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Please Read This Notice 

Successful application of this module requires a reasonable working knowledge of the ProLinx Module, its connected 
devices, and the application in which the combination is to be used. For this reason, it is important that those 
responsible for implementation satisfy themselves that the combination will meet the needs of the application without 
exposing personnel or equipment to unsafe or inappropriate working conditions. 

This manual is provided to assist the user. Every attempt has been made to assure that the information provided is 
accurate and a true reflection of the product's installation requirements. In order to assure a complete understanding 
of the operation of the product, the user should read all applicable documentation on the operation of the connected 
devices. 

Under no conditions will ProSoft Technology be responsible or liable for indirect or consequential damages resulting 
from the use or application of the product. 

Reproduction of the contents of this manual, in whole or in part, without written permission from ProSoft Technology 
is prohibited. 

Information in this manual is subject to change without notice and does not represent a commitment on the part of 
ProSoft Technology Improvements and/or changes in this manual or the product may be made at any time. These 
changes will be made periodically to correct technical inaccuracies or typographical errors. 

Important Installation Instructions 

Power, Input and Output (I/O) wiring must be in accordance with Class I, Division 2 wiring methods, Article 501-4 (b) 
of the National Electrical Code, NFPA 70 for installation in the U.S., or as specified in Section 18-1J2 of the Canadian 
Electrical Code for installations in Canada, and in accordance with the authority having jurisdiction. The following 
warnings must be heeded: 

A WARNING - EXPLOSION HAZARD - SUBSTITUTION OF COMPONENTS MAY IMPAIR SUITABILITY FOR 
CLASS I, DIV. 2; 

B WARNING - EXPLOSION HAZARD - WHEN IN HAZARDOUS LOCATIONS, TURN OFF POWER BEFORE 
REPLACING OR WIRING MODULES, and 

C WARNING - EXPLOSION HAZARD - DO NOT DISCONNECT EQUIPMENT UNLESS POWER HAS BEEN 
SWITCHED OFF OR THE AREA IS KNOWN TO BE NONHAZARDOUS. 

D "THIS DEVICE SHALL BE POWERED BY CLASS 2 OUTPUTS ONLY. 

All ProLinx® Products 

WARNING – EXPLOSION HAZARD – DO NOT DISCONNECT EQUIPMENT UNLESS POWER HAS BEEN 
SWITCHED OFF OR THE AREA IS KNOWN TO BE NON-HAZARDOUS. 
AVERTISSEMENT – RISQUE D'EXPLOSION – AVANT DE DÉCONNECTER L'EQUIPMENT, COUPER LE 
COURANT OU S'ASSURER QUE L'EMPLACEMENT EST DÉSIGNÉ NON DANGEREUX.  

 
CL I Div 2 GP A, B, C, D 
Temp Code T5 
II 3 G 
Ex nA nL IIC T4 X 
0° C <= Ta <= 60° C 
II – Equipment intended for above ground use (not for use in mines). 
3 – Category 3 equipment, investigated for normal operation only. 
G – Equipment protected against explosive gasses. 



 

 

ProLinx Modules with Ethernet Ports 

Series C ProLinx™ modules with Ethernet ports do NOT include the HTML Web Server. The HTML Web Server must 
be ordered as an option. This option requires a factory-installed hardware addition. The HTML Web Server now 
supports: 

 8 MB file storage for HTML files and associated graphics files (previously limited to 384K) 
 32K maximum HTML page size (previously limited to 16K) 

To upgrade a previously purchased Series C model: 

Contact your ProSoft Technology distributor to order the upgrade and obtain a Returned Merchandise Authorization 
(RMA) to return the unit to ProSoft Technology. 

To Order a Series C mode with the -WEB option: 

Add -WEB to the standard ProLinx part number. For example, 5201-MNET-MCM-WEB. 

ProLinx Plus with Radio 

The following Information and warnings pertaining to the radio module must be heeded: 

A "THIS DEVICE CONTAINS A TRANSMITTER MODULE, FCC ID: SDZ-WA-1. PLEASE SEE FCC ID LABEL ON 
BACK OF DEVICE." 

B "THIS DEVICE USES AN INTERNAL COMPACT FLASH RADIO MODULE AS THE PRIMARY RADIO 
COMPONENT. THE COMPACT FLASH RADIO MODULE DOES NOT HAVE AN FCC ID LABEL. THE 
COMPACT FLASH RADIO MODULE HAS NO USER SERVICABLE PARTS." 

C "THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO THE 
FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL INTERFERENCE, AND (2) 
THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, INCLUDING INTERFERENCE THAT MAY 
CAUSE UNDESIRED OPERATION." 

D "THIS DEVICE AND ANY RADIO ACCESSORY SOLD BY PROSOFT MUST BE INSTALLED BY AN 
AUTHORIZED PROFESSIONAL INDUSTRIAL RADIO SYSTEM INTEGRATOR. FURTHER, ONLY RADIO 
ACCESSORIES SOLD BY PROSOFT AND SPECIFICALLY TESTED FOR USE WITH THIS DEVICE MAY BE 
USED WITH THIS DEVICE." 

E "THE USER OF THIS EQUIPMENT CANNOT BE WITHIN 20 cm. FROM THE RADIATING ELEMENT DEVICE." 
F "CHANGES OR MODIFICATIONS NOT EXPRESSLY APPROVED BY THE PARTY RESPONSIBLE FOR 

COMPLIANCE COULD VOID THE USER'S AUTHORITY TO OPERATE THE EQUIPMENT." 

Industry Canada Requirements: 

A "THIS DEVICE HAS BEEN DESIGNED TO OPERATE WITH AN ANTENNA HAVING A MAXIMUM GAIN OF 24 
dB. AN ANTENNA HAVING A HIGHER GAIN IS STRICTLY PROHIBITED PER REGULATIONS OF INDUSTRY 
CANADA. THE REQUIRED ANTENNA IMPEDANCE IS 50 OHMS." 

B "TO REDUCE POTENTIAL RADIO INTERFERENCE TO OTHER USERS, THE ANTENNA TYPE AND ITS 
GAIN SHOULD BE CHOSEN SUCH THAT THE EQUIVALENT ISOTROPICALLY RADIATED POWER (EIRP) 
IS NOT MORE THAN THAT REQUIRED FOR SUCCESSFUL COMMUNICATION." 

C "THE INSTALLER OF THIS RADIO EQUIPMENT MUST INSURE THAT THE ANTENNA IS LOCATED OR 
POINTED SUCH THAT IT DOES NOT EMIT RF FIELD IN EXCESS OF HEALTH CANADA LIMITS FOR THE 
GENERAL POPULATION; CONSULT SAFETY CODE 6, OBTAINABLE FROM HEALTH CANADA." 

WARNING: 

This is a Class A product. In a domestic environment this product may cause radio interference 
in which case the user may be required to take adequate measures. 
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Guide to the ProLinx Reference Guide 

Function  Section to Read Details 

Introduction 

(Must Do) 

 Start Here (page 9) This Section introduces the customer to the 
module. Included are: package contents, 
system requirements, hardware installation, and 
basic configuration. 

   

Verify Communication, 
Diagnostic and 
Troubleshooting 

 Verifying 
Communication 
(page 75) 

Diagnostics and 
Troubleshooting 
(page 59) 

This section describes how to verify 
communications with the network. Diagnostic 
and Troubleshooting procedures. 

   

Reference 

Product Specifications 

Functional Overview 

Glossary 

 Reference (page 89)

Functional Overview 
(page 85) 

Product 
Specifications (page 
89) 

These sections contain general references 
associated with this product, Specifications, and 
the Functional Overview. 

    

Support, Service, and 
Warranty 

Index 

 Support, Service 
and Warranty (page 
112) 

This section contains Support, Service and 
Warranty information.  

Index of chapters. 
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1 Start Here 

In This Chapter 

 System Requirements ............................................................................. 9 

 Package Contents ................................................................................. 10 

 Setting Port 0 Configuration Jumpers .................................................... 11 

 Mounting the Module on the DIN Rail .................................................... 12 

 Connecting Power to the Unit ................................................................ 12 

 RS-232 Serial Connection ..................................................................... 13 

 Install ProSoft Configuration Builder Software ....................................... 14 

 Configure the Module ............................................................................ 16 

 

1.1 System Requirements 

The ProSoft Configuration Builder for the ProLinx module requires the following 
minimum hardware and software components: 

 Pentium® II 450 MHz minimum. Pentium III 733 MHz (or better) 
recommended  

 Supported operating systems: 
o Microsoft Windows XP Professional with Service Pack 1 or 2  
o Microsoft Windows 2000 Professional with Service Pack 1, 2, or 3 
o Microsoft Windows Server 2003  

 128 Megabytes of RAM minimum, 256 Megabytes of RAM recommended  
 100 Megabytes of free hard disk space (or more based on application 

requirements)  
 256-color VGA graphics adapter, 800 x 600 minimum resolution (True Color 

1024  768 recommended)  
 CD-ROM drive 
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1.2 Package Contents 

The following components are included with your ProLinx module, and are all 
required for installation and configuration.  

Important: Before beginning the installation, please verify that all of the following items are 
present.  

Qty.  Part Name Part Number Part Description 

1  ProLinx 
Module 

PLX-#### ProLinx communication gateway module 

1 Cable Cable #15, RS232 
Null Modem  

For RS232 Connection to the CFG Port 

Varies Cable Cable #9, Mini-DIN8 
to DB9 Male 
Adapter 

For DB9 Connection to Module's Port. One DIN to 
DB-9M cable included per configurable serial port 

Varies Adapter 1454-9F Adapters, DB9 Female to Screw Terminal. For 
RS422 or RS485 Connections to each serial 
application port of the Module 

1   ProSoft 
Solutions CD 

 Contains sample programs, utilities and 
documentation for the ProLinx module.  

If any of these components are missing, please contact ProSoft Technology 
Support for replacement parts.  
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1.3 Setting Port 0 Configuration Jumpers 

Before installing the module on the DIN rail, you must set the jumpers for the Port 
0 application port.  

 

Note: Ethernet-only ProLinx modules do not use the serial port jumper settings. The serial 
configuration jumper settings on an Ethernet-only module have no effect.  
Note: The presence of Port 0 depends on the specific combination of protocols in your ProLinx 
module. If your module does not have a Port 0, the following jumper settings do not apply. 

 

Port 0 is preconfigured for RS-232. You can move the port configuration jumper 
on the back of the module to select RS-485 or RS-422.  

The following illustration shows the jumper positions for Port 0: 

 

ProLinx 5000/6000 Series Module 
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1.4 Mounting the Module on the DIN Rail 

 

ProLinx 5000/6000 Series Module 

1.5 Connecting Power to the Unit 

 

 

WARNING: Ensure that you do not reverse polarity when applying power to the module. This will 
cause damage to the module's power supply. 



Start Here ProLinx ♦ ProLinx Gateways 
 Configuration and Troubleshooting 

 

ProSoft Technology, Inc. Page 13 of 123 
April 14, 2011 
 

1.6 RS-232 Serial Connection 

 

This port is physically a Mini-DIN connection. A Mini-DIN to DB-9 adapter cable 
is included with the module. This port permits a PC based terminal emulation 
program to view configuration and status data in the module and to control the 
module. The cable for communications on this port is shown in the following 
diagram: 
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1.7 Install ProSoft Configuration Builder Software 

You must install the ProSoft Configuration Builder (PCB) software in order to 
configure the ProLinx module. You can always get the newest version of ProSoft 
Configuration Builder from the ProSoft Technology web site. 

To install ProSoft Configuration Builder from the ProSoft Web Site 

1 Open your web browser and navigate to http://www.prosoft-
technology.com/pcb 

2 Click the Download Here link to download the latest version of ProSoft 
Configuration Builder.  

3 Choose "Save" or "Save File" when prompted. The following illustrations 
show the file download prompt for two of the most common web browsers.  

 

 

4 Make a note of the location where you saved the file, for example "Desktop", 
or "My Documents", so you can start the installation program.  

5 When the download is complete, locate and open the file, and then follow the 
instructions on your screen to install the program. 

If you do not have access to the Internet, you can install ProSoft Configuration 
Builder from the ProSoft Solutions CD-ROM, included in the package with your 
ProLinx module. 
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To install ProSoft Configuration Builder from the CD-ROM 

1 Insert the ProSoft Solutions CD-ROM into the CD drive of your PC. Wait for 
the startup screen to appear. 

2 On the startup screen, click Product Documentation. This action opens an 
explorer window.  

3 Click to open the Utilities folder. This folder contains all of the applications 
and files you will need to set up and configure your module. 

4 Double-click the ProSoft Configuration Builder Setup program and follow the 
instructions on your screen to install the software on your PC. 
 

Note: Many of the configuration and maintenance procedures use files and other utilities on the 
CD-ROM. You may wish to copy the files from the Utilities folder on the CD-ROM to a convenient 
location on your hard drive.  

 

1.7.1 Using the help system 

Most of the information needed to help you use ProSoft Configuration Builder is 
provided in a help system that is always available whenever you are running 
ProSoft Configuration Builder. The help system does not require an Internet 
connection. 

To view the help pages, start ProSoft Configuration Builder, open the Help menu, 
and then choose Contents. 
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1.8 Configure the Module 

1.8.1 Adding a Location 

To add a location to an existing project file: 

1 Right-click the Project icon and select Add Location. A new Location icon 
appears. 

or 
Select the Project icon. 

2 Choose Project from the Project menu, then choose Add Location. A new 
Location icon appears. 

or 
If the Default Location has not been named (is not already an existing 
project), right-click the folder and choose Rename. 

3 Type in the Location name. 

1.8.2 Adding a Project 

To add a project to an existing project file: 

1 Select the Default Project icon. 
2 Choose Project from the Project menu, then choose Add Project. A new 

project folder appears. 

1.8.3 Adding a Module 

To add a module to your project: 

1 Double-click the Default Module icon to open the Choose Module Type dialog 
box. 

2 On the Choose Module Type dialog box, select the module type. 

Or 

1 Open the Project menu and choose Location.  
2 On the Location menu, choose Add Module. 

To add a module to a different location: 

1 Right-click the Location folder and choose Add Module. A new module icon 
appears. 

Or 

1 Select the Location icon. 
2 From the Project menu, select Location, then select Add Module. 
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1.8.4 Module Entries 

To configure module parameters 

1 Click on the plus sign next to the icon  to expand module 
information. 

2 Double-click the  icon to open the Edit dialog box. 
3 To edit a parameter, select the parameter in the left pane and make your 

changes in the right pane. 
4 Click OK to save your changes. 

1.8.5 Comment Entries 

To add comments to your configuration file: 

1 Click the plus sign to the left of the  icon to expand the Module 
Comments.  

2 Double-click the  icon. The Edit - Module Comment dialog 
appears. 

 

3 Enter your comment and click OK to save your changes. 

1.8.6 Printing a Configuration File 

To print a configuration file: 

1 Select the Module icon, and then click the right mouse button to open a 
shortcut menu.  

2 On the shortcut menu, choose View Configuration. This action opens the 
View Configuration window. 

3 On the View Configuration window, open the File menu, and choose Print. 
This action opens the Print dialog box. 

4 On the Print dialog box, choose the printer to use from the dropdown list, 
select printing options, and then click OK. 
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1.8.7 Downloading a File from PC to the Module 

To download a file from the Configuration Builder to the module: 

1 Verify that your PC is connected to the module with a null-modem serial cable 
connected to the serial port on your PC and the serial port on the module 

2 Open the Project Menu, and then choose Module. 
3 On the Module menu, choose Download. Wait while ProSoft Configuration 

scans for communication ports on your PC. When the scan is complete, the 
Download dialog box opens.  

 

4 Select the port to use for the download.  
5 Click the Download button. 
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2 ProSoft Configuration Builder 

In This Chapter 

 About ProSoft Configuration Builder ...................................................... 19 

 Views ..................................................................................................... 24 

 User Interface ........................................................................................ 26 

 Common Tasks ..................................................................................... 30 

 Support .................................................................................................. 36 

ProSoft Configuration Builder is an application (computer program) that simplifies 
the task of managing the configuration files that control how your ProSoft module 
operates.  

The following topics describe some of the features of ProSoft Configuration 
Builder. For complete online documentation, please use the ProSoft 
Configuration Builder online help.  

2.1 About ProSoft Configuration Builder 

ProSoft Configuration Builder helps you create a configuration project and 
download the project to your ProSoft Module. 

The Configuration Builder consists of the following views: 

 Tree View (page 25) 
 Information View (page 24) 
 Configuration View (page 24) 
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Each view provides different types of information about your project. When you 
first open ProSoft Configuration Builder, you are presented with a clean file that 
contains a Default Project Folder, a Default Location Folder, and a Default 
Module Folder displayed in the Tree View (page 25) portion of the window. 

 

Here you can… 

 Name the Project 
 Name the Default Location (page 16) 
 Choose the Module Type (page 16) 

The tree expands to show information in a tree view. You can have multiple 
locations within a project and multiple modules at a location. 
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Clicking on the  of the module icon provides specific information about the 
module. Information types are designated by icons. 

Click  on each icon for more information. 

 

Selecting any of the icons provides you with information in the Information View 
and the Configuration View. 

Both the Information View and the Configuration View contain information 
specific to the selected icon. 

 

In this example, both views are showing information pertaining to the Modbus 
Master/Slave protocol (selected in the tree view). With this type of selection, the 
Configuration View shows all configuration sections that pertain to the selected 
protocol. That is, [Modbus Port 0], and [Modbus Port 0 Commands]. 

As you can see in the Tree View, the subsections under the MCM Port 0 protocol 
icon have a direct correlation to the configuration sections shown in the 
Configuration View. 
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Please note that some parameters in the Configuration View contain default 
settings, while others do not. 

To focus on one section at a time, click the desired section in the tree view. 

 

You can edit any of the default parameters as well as define other configurable 
parameters as required. Double-clicking any of the icons brings you into edit 
mode. For example, double-clicking on the Radio Configuration tag group icon 
brings you to the Edit - RADIO CONFIGURATION window. 
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This window lets you edit and add comments to each of the default parameters. 
You select the parameter you want to edit and change the values. 

To enter values in sections that do not contain default values, double-click the 
appropriate icon. For example, if you double-Click the Radio PWP Exchanges 
icon, the Edit - RADIO PWP EXCHANGES window appears. 

 

The edit windows guide you through the module configuration process. All 
windows contain context-sensitive online help to answer questions you may have 
during the configuration process. 

In addition to creating configuration files for your module, ProSoft Configuration 
Builder also lets you… 

 Transfer and modify existing configuration files from the module 
 Set up External File Locations 
 Export the configuration to text files 
 Get email support that packages and sends the Diagnostics log file to 

technical support 
 Run Diagnostics 

After you are happy with your configuration, you can download it directly to the 
module through a simple menu selection. 



ProLinx ♦ ProLinx Gateways ProSoft Configuration Builder 
Configuration and Troubleshooting  

 

Page 24 of 123  ProSoft Technology, Inc. 
April 14, 2011 

 

2.2 Views 

2.2.1 Configuration View 

The configuration view is located in the lower right-hand pane of the display. This 
view shows the configuration file as it is created with current values displayed. 

 

2.2.2 Information View 

The information view is located in the upper right-hand pane of the display. This 
view provides information relating to the selections made in the tree view. 

 



ProSoft Configuration Builder ProLinx ♦ ProLinx Gateways 
 Configuration and Troubleshooting 

 

ProSoft Technology, Inc. Page 25 of 123 
April 14, 2011 
 

2.2.3 Tree View 

The Tree View pane of the Configuration Builder provides a tree-like view of your 
project. The following is an example tree view. 

 

Clicking the  or   icons to expand or collapse sections of the tree view. 
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2.3 User Interface 

2.3.1 Choose Module Type dialog box 

This dialog box opens when you select a module, and then choose "Choose 
Module Type" from the shortcut menu.  

Use this dialog box to select the type of module to configure, and define some 
basic configuration for the ports on the module. 

 

Product Line Filter 

Select Module Type 

Define Ports Area 

Enabled ports are shown on the Choose Module Type dialog box with a 
checkmark . 

To enable or disable a port, click the port to select it, then click the icon.  

 Shows that the port is Enabled. To switch to Disabled, click the icon. 

 Shows that the port is currently disabled but can be changed to Enabled. To 
switch to enabled, click the icon. 

 Shows that the port is not configured. This port cannot be set to "Enabled" 
unless the port before it is enabled. 
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2.3.2 Diagnostics dialog box 

This dialog box opens when you select a module in the Tree View, and then 
choose Diagnostics from the shortcut menu. 

The Diagnostics dialog box is a simple terminal window that allows you to 
connect to the module's configuration/debug menu to view module status and 
configuration. The Diagnostics dialog box also has other functions to help you 
manage your module: 

 You can download the configuration (created and saved in ProSoft 
Configuration Builder) to the module, to customize the module for your 
application.  

 You can save the data from your terminal session to a text file. This text file 
can be helpful for support and debugging purposes.  

 The Diagnostics dialog box has a COM port selector dropdown list for 
choosing the connection to the module.  

Choose the connection type from the dropdown list.  

  

Download Config - Click this button to send the current configuration file to the 
module. 

Log to File - Click this button to specify a location on your hard drive where you 
can save diagnostic information to a file. You can later use this file for analysis 
and troubleshooting. 

Email Log to Support - Click this button to sends configuration information in an 
email message to ProSoft Technical Support for analysis and troubleshooting. 

Clear File - Select (check) this box to clear the contents of the Log file and start 
a new session. 

Click Close to return to the ProSoft Configuration window. 

Terminal Window  - Press [?] to display the module's Main Menu. 
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Because this is a text-based menu system, you enter commands by typing the 
command letter from your computer keyboard in the diagnostic window in 
ProSoft Configuration Builder (PCB). The module does not respond to mouse 
movements or clicks. The command executes as soon as you press the 
command letter — you do not need to press [Enter]. When you type a command 
letter, a new screen will be displayed in your terminal application. 

 

If there is no response from the module, follow these steps: 

1 Verify that the cable is connected properly between your computer and the 
module. A null modem serial cable is required. 

2 On computers with more than one serial port, verify that ProSoft 
Configuration Builder is connected to the same port that is connected to the 
module. 

2.3.3 Edit dialog box 

This dialog box opens when you double-click an object associated with a module.  

The left pane in this dialog box displays the parameters you can configure for the 
tag (object) you are editing. The list of parameters changes, depending on the 
type of object. 

On the right pane, the top field, displays the name of the parameter you are 
currently editing. This field is for your information only, and cannot be modified. 

The value field is where you type the value for the parameter you are editing. 
Refer to the helper text below the data entry areas for helpful information.  

Click Reset Tag to discard your edits, and restore the default value to the tag 
you are editing.  

Click Reset All to discard all the edits for the parameters in this group, and 
restore the default values.  

Click OK to save your edits and close the dialog box. 

Click Cancel to discard your edits and close the dialog box.  
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2.3.4 Upload/Download dialog box 

This dialog box opens when you select a module in the Tree View, and then 
choose Download or Upload from the shortcut menu. 

The Upload/Download dialog box is used to download files from your PC to the 
module or Upload files from the module to your PC for editing.  

This dialog box contains a status display and a progress bar. It also lets you 
choose the Com port to use. When you are ready, click the Download button. 

2.3.5 View Configuration dialog box 

This dialog box opens when you select a module in the Tree View, and then 
choose View Configuration from the shortcut menu. 

The View Configuration Dialog lets you view the current configuration settings of 
the module you selected. When using the View Configuration menu selection, the 
following dialog appears: 

 

2.3.6 Select Protocol dialog box 

This dialog box opens when you select a Port Icon and then choose Select 
Protocol from the Project / Port menu.  
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2.3.7 Data Map Edit Dialog box 

This dialog box opens when you select an object with a Data Map icon and then 
choose "Configure" from the shortcut menu.  

The Data Map Edit dialog box allows you to set up commands and parameters 
for each command. Use the Add Row button to add a new row of data. This 
screen also contains buttons to set a row back to its default settings, insert or 
delete a row, move rows up or down, and edit or copy an existing row. 

OK Button: Click the OK Button to accept and save changes to the dialog. 

Cancel Button: Click the Cancel button to cancel the previous changes and re-
edit rows in the dialog. 

2.4 Common Tasks 

2.4.1 Adding External (Web) Files 

On modules equipped with the -WEB hardware option, you can specify the HTML 
files to include with the configuration.  

To add an external file: 

1 From the Project menu, select Module 
2 On the Module shortcut menu, choose Add External File. 

2.4.2 Copying Group Information 

To copy Tag group information: 

1 Right-click on Tag Group  icon and select Copy. 

or 
Select the Tag Group icon. 

2 From the Project Menu, select Group, then select Copy. 

2.4.3 Copying Module Information 

To copy module information: 

1 Right-click the Module icon. 
2 Choose Copy. 

or 
From the Project Menu, select Module, then select Copy. 
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2.4.4 Deleting a Location 

To delete a Location: 

1 Right-click the Location icon that you want to delete 
2 On the shortcut menu, choose Delete. 

or 

1 From the Project menu, choose Location. 
2 On the Location menu, choose Delete. 

2.4.5 Deleting a Module 

To delete a module from your project: 

1 Right-click the Module to delete 
2 On the shortcut menu, choose Delete. 

or 

1 From the Project menu, select Module. 
2 On the Module menu, choose Delete. 

2.4.6 Deleting a Project 

To delete a project: 

1 Right-click the Project icon. 
2 On the shortcut menu, choose Delete. 

or 

1 From the Project menu, choose Project 
2 On the Project menu, choose Delete. 

2.4.7 Enable Configurable Items 

Available configuration items (for example, ports or data types) are shown on the 
Choose Module Type dialog box. Enabled items are shown with a check mark . 

In order to select whether an item is enabled or disabled, click the port to select 
it, then click the icon to enable or disable the port. Clicking on the port will 
provide you with one of the following icons. 

 Shows that the item is associated with a protocol and available for 
configuration.  

 Shows that the item s not associated with a protocol. 

 Shows that the item is not configured.  

Use the Chose Module Type dialog box to select and change these options.  
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2.4.8 Downloading a File from PC to the Module 

To download a file from the Configuration Builder to the module: 

1 Verify that your PC is connected to the module with a null-modem serial cable 
connected to the serial port on your PC and the serial port on the module 

2 Open the Project Menu, and then choose Module. 
3 On the Module menu, choose Download. Wait while ProSoft Configuration 

scans for communication ports on your PC. When the scan is complete, the 
Download dialog box opens.  

 

4 Select the port to use for the download.  
5 Click the Download button. 

2.4.9 Exporting Configuration Files 

Modules get their configuration information from one or more configuration files 
(CFG Files). ProSoft Configuration Builder creates the necessary configuration 
files with the appropriate sections. When you are satisfied with your configuration 
project, you can export the configuration information that you created with 
Configuration Builder, and then download the files to the module or import them 
into other applications, depending on the protocol requirements. 

Perform the following steps to export your configuration files. 

1 From the Project menu, select Module, then select Export Configuration Files. 
ProSoft Configuration Builder prompts you for a Location to store the files. 

2 Select a location a choose OK. 

If you are satisfied with your configuration, you can then download the 
configuration to the module. 
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2.4.10 Ethernet Configuration Entries 

To change default Ethernet configuration parameters … 

1 Double click on the  icon. This action opens the Edit - 
WATTCP dialog box. 

 

2 Select each parameter on the left pane of the window, and then edit or select 
the value to use in the text window in the right pane.  

3 Click OK to save your changes and close the dialog box. 

2.4.11 Module Entries 

To configure module parameters 

1 Click on the plus sign next to the icon  to expand module 
information. 

2 Double-click the  icon to open the Edit dialog box. 
3 To edit a parameter, select the parameter in the left pane and make your 

changes in the right pane. 
4 Click OK to save your changes. 
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2.4.12 Pasting Group Information 

To paste Tag Group information into your project, first select the information and 
copy (page 30) it to the clipboard.  

To paste group information: 

1 Right-click the tag group where you want to paste the copied group 
information. 

2 On the shortcut menu, choose Paste Group. 

or 

1 Open the Project Menu and choose Group. 
2 On the Group menu, choose Paste Group. 

2.4.13 Pasting Module Information 

To paste module information into your project, first select the information and 
copy (page 30) it to the clipboard.  

To paste module information: 

1 Right-click the Location where you want to paste the copied module 
information. 

2 On the shortcut menu, choose Paste Module. 

or 

1 Open the Project Menu and choose Module 
2 On the Module menu, choose Paste Module. 

2.4.14 Renaming a Module 

To rename a module: 

1 Right-click the Module icon and choose Rename. 
2 Type in the new name of the module. 

or 

1 From the Project menu, choose Module, then choose Rename. 
2 Type in the new name of the module. 

2.4.15 Renaming a Project 

To rename a project: 

1 Right-click the Project icon and choose Rename. 
2 Type in the new name of the project. 

or 

1 From the Project menu, choose Project, then choose Rename. 
2 Type in the name of the Project. 
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2.4.16 Renaming a Location 

To rename a Location: 
1 Right-click the Location icon and choose Rename. 
2 Type in the new name of the Location. 

or 

1 From the Project Menu, choose Location, then choose Rename. 
2 Type in the name of the Location. 

2.4.17 Selecting a Protocol 

To select a protocol: 

1 From the tree view, click the protocol  icon. 
2 Double-click the icons under the protocol to configure individual protocol 

options.  

Tip: You can copy information from one protocol and paste it to another instance of the same 
protocol. For example, the same protocol using more than one port. 

2.4.18 Selecting a Tag 

Double-click a tag in the list view to view or edit its values.  

2.4.19 Setting an External (Web) File Location 

On modules equipped with the -WEB hardware option, you can specify the folder 
containing your HTML files to include with the configuration.  

To set an external file location: 
1 From the Project Menu, choose File. 
2 Choose Set External File Location. 

2.4.20 Transferring a File from the Module 

1 To transfer a project file from the module to the Configuration Builder: 
2 From the Project menu, choose Module, then choose Upload. The Upload 

Dialog appears. 

 

3 Select the port (serial or Ethernet) to connect to the module.  
4 Click on the Upload button. 
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2.5 Support 

2.5.1 Exporting Configuration Files 

Modules get their configuration information from one or more configuration files 
(CFG Files). ProSoft Configuration Builder creates the necessary configuration 
files with the appropriate sections. When you are satisfied with your configuration 
project, you can export the configuration information that you created with 
Configuration Builder, and then download the files to the module or import them 
into other applications, depending on the protocol requirements. 

Perform the following steps to export your configuration files. 

1 From the Project menu, select Module, then select Export Configuration Files. 
ProSoft Configuration Builder prompts you for a Location to store the files. 

2 Select a location a choose OK. 

If you are satisfied with your configuration, you can then download the 
configuration to the module. 

2.5.2 Getting Email Support 

The Configuration Builder can email your diagnostic log files to ProSoft Technical 
Support. Technical Support can analyze your file to help you diagnose problems 
with your module.  

1 From the Diagnostics window, click the Log to File button. This action creates 
a text file containing a log of your diagnostics section.  

2 When you have finished recording, click the Stop Logging button. This action 
closes the text file.  

3 To send the log file by email, click the Email Log to Support button. This 
action launches your default email program and attaches the text file to an 
email message addressed to support@prosoft-technology.com 

4 In the message body, add any information you feel would be helpful to the 
technical support group, and then send the message. 
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2.5.3 Viewing Diagnostic Information 

To view diagnostic information: 

Right-click the module and select Diagnostics. 

 

The Diagnostics window opens displaying the Diagnostics Menu items available 
for the module you selected. 

Select the Connection type from the Connection drop-down list. 

2.5.4 Sending the Log to a File 

Click the Log to File button to record the current diagnostics session to a text file. 
The text file may be useful for support and troubleshooting purposes.  
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3 Application Ports 

In This Chapter 

 Serial Port Cable Connections: Config/Debug and Port 0 ..................... 39 

 Serial Port Cable Connections: Multiple Port Units ............................... 39 

 Configuration/Debug Port ...................................................................... 43 

 DB9 to Mini-DIN Adaptor (Cable 09) ..................................................... 43 

 Ethernet Port ......................................................................................... 44 

 Special Ports ......................................................................................... 44 

3.1 Serial Port Cable Connections: Config/Debug and Port 0 

This section contains information on the cable and pin assignments for the 
ProLinx Communication Gateway module application serial ports (RS-
232/422/485). 

The module will come with one to five serial ports, depending on the 
configuration purchased. In all cases, the protocol serial ports will have the same 
pin-outs. 

Each serial port is a Mini-DIN physical connection. A 6-inch 'Mini-DIN to DB-9M' 
cable is provided for each active protocol port. The DB-9M provides connections 
for RS-232, RS-422 and RS-485, as well as for the Debug port. The diagrams in 
the following topics detail the pin assignments for several possible physical 
connections. 

The relationship between the port labeling on the front of the ProLinx module and 
the application is as follows: 

Port Label Function 

Debug Debug/Configuration 

Port 0 Application Port 0 
 

3.2 Serial Port Cable Connections: Multiple Port Units 

The relationship between the port labeling on the front of the ProLinx module and 
the application is as follows: 

The following ports only exist on multiple port units 

Port 1 Application Port 1 

Port 2 Application Port 2 

Port 3 Application Port 3 
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3.2.1 Port 0,1,2,3: RS-232 - Null Modem (with Hardware 
Handshaking) 

This type of connection is used when the device connected to the module 
requires hardware handshaking (control and monitoring of modem signal lines). 

 

3.2.2 Port 0,1,2,3: RS-232 - Null Modem (without Hardware 
Handshaking) 

This type of connection can be used to connect the module to a computer or field 
device communication port. 

 

Note: If the port is configured with the "Use CTS Line" set to 'Y', then a jumper is required between 
the RTS and the CTS line on the module connection. 
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3.2.3 Port 0,1,2,3: RS-232 - Modem Connection 

This type of connection is required between the module and a modem or other 
communication device. 

 

The "Use CTS Line" parameter for the port configuration should be set to 'Y' for 
most modem applications. 

3.2.4 Port 0,1,2,3: RS-422 Interface Connections 

The following illustration applies when the RS-422 interface is selected. 
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3.2.5 Port 0,1,2,3: RS-485 Interface Connections 

The following illustration applies when the RS-485 interface is selected. 

 

3.2.6 Collision Avoidance (DNP modules only) 

The RTS line is controlled by the RTS on and off parameters set for the port. If 
the CTS line is used (usually only required for half-duplex modems and not 
defined for use in the DNPS specification), the RTS and CTS lines must either be 
connected together or connected to the modem. The following illustration shows 
the cable required when connecting the port to a modem. 

 

If collision avoidance is used in a point-to-point connection on the RS-232 
interface, the following cable should be used. 

 



Application Ports ProLinx ♦ ProLinx Gateways 
 Configuration and Troubleshooting 

 

ProSoft Technology, Inc. Page 43 of 123 
April 14, 2011 
 

3.3 Configuration/Debug Port 

This port is physically a Mini-DIN connection. A Mini-DIN to DB-9 adapter cable 
is included with the module. This port permits a PC based terminal emulation 
program to view configuration and status data in the module and to control the 
module. The cable for communications on this port is shown in the following 
diagram: 

 

3.4 DB9 to Mini-DIN Adaptor (Cable 09) 
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3.5 Ethernet Port 

3.5.1 RJ45 

Every Ethernet module includes 10base-T RJ45 port which can be used to 
communicate to any onboard Ethernet protocols. If both module protocols are 
Ethernet you must supply a hub or switch to connect both device types to the 
single port. 

3.5.2 Ethernet Cable Configuration 

Note: The standard connector view shown is color-coded for a straight-through cable. 

Crossover cable 

 

Straight- through cable 

RJ-45 PIN RJ-45 PIN RJ-45 PIN RJ-45 PIN 

1 Rx+ 3 Tx+ 1 Rx+ 1 Tx+ 

2 Rx- 6 Tx- 2 Rx- 2 Tx- 

3 Tx+ 1 Rx+ 3 Tx+ 3 Rx+ 

6 Tx- 2 Rx- 6 Tx- 6 Rx- 

 

3.6 Special Ports 

3.6.1 PROFIBUS Master Port 

The following diagram has been imported from the PROFIBUS Master 
documentation. Note that the signals to reference are the D-Sub signals in the 
table 
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Constructing a Bus Cable for PROFIBUS DP 

The bus cable for connecting PROFIBUS DP devices must be constructed by the 
user. A special PROFIBUS cable (twisted pair) is required here. This standard 
cable is available from various manufacturers and is a Belden part number 
3079A.  

If you plan to construct your own bus cable, the following part numbers are 
provided for your convenience. 

 PROFIBUS connector: Siemens part number 6ES7972-0BA40-0XA0 
 PROFIBUS cable: Belden part number 3079A. 

To construct the cable, proceed as follows: 

1 Cut the cable to the required length. 
2 Prepare the cable ends as shown in the illustration (dimensions in mm): 

 

J PVC Jacket 
S Braided shielding 

3 Remove the PVC jacket J to the indicated length. 
4 Wrap the provided copper shielding F around the shield braiding S: 

 

J PVC jacket 
S Braided shielding 
F Copper foil shielding 
Additional foil can be obtained from 3M.  

5 Plug the leads of the corresponding cable(s) into the terminals as shown: 

o Green leads in terminal A 
o Read lead in terminal B 

 Note: Do not tighten the corresponding screws yet. 
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Connection terminal assignment on the PROFIBUS DP: 

 

A Incoming cable  
B Outgoing cable  
C Connection terminals (only once (B,A)) 
D Cable cleat for reliving tension 
E Bus connector screws 

6 Attach the cables with the provided cable cleat to create a robust shielded 
connection and to relieve any tension as shown: 

  

J PVC Jacket 
S Braided shielding with foil shielding 
C Cable cleat 

 Note: Half of the cable jacket must lie under the cable cleat! 

Pay attention to the cable cleat installation instructions. 

7 Fasten the individual wires of the PROFIBUS cable to the terminals 
8 Close the connector housing. 

 Note: The shielding of both cables is connected internally with the metal housing of the 
connector. 
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9 Complete the Central Shielding Measures (below) and grounding operations 
for the shielding before you connect the cable connector to the module. 

10 Plug the PROFIBUS DP connector into the module and secure it with the 
screws. 

Bus Begin and Bus End 

The PROFIBUS connector with termination is required at the beginning and the 
end of the bus. These connectors emulate the line impedance. 

It is recommended that at least one connector with diagnostics interface is used. 

Wiring diagram for a PROFIBUS DP cable 

 

Grounding and Shielding for Systems with Equipotential Bonding 

Each cable shield should be galvanically grounded with the earth using FE/PE 
grounding clamps immediately after the cable has been connected to the cabinet. 

This example indicates the shielding connection from the PROFIBUS cable to the 
FE/PE rail. 

 

Note: An equalization current can flow across a shield connected at both ends because of 
fluctuations in ground potential. To prevent this, it is imperative that there is potential equalization 
between all the attached installation components and devices. 
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This example indicates the system components and devices in a system with 
equipotential bonding. 

 

Grounding and Shielding for Systems without Equipotential Bonding 

Note: Grounding and shielding is to be carried out the same as for systems with equipotential 
bonding.  

If this is not possible because of system or construction specific reasons 
however, use distributed ground with a capacitive coupling of high frequency 
interference signals.  

This representation shows distributed grounding with capacitive coupling. 

 



Application Ports ProLinx ♦ ProLinx Gateways 
 Configuration and Troubleshooting 

 

ProSoft Technology, Inc. Page 49 of 123 
April 14, 2011 
 

 

3.6.2 PROFIBUS Slave Port 

The ProLinx module supports this protocol as a slave module on a PROFIBUS 
network. 

The relationship between the port labeling on the front of the ProLinx module and 
the application is as follows: 

Port Label Function 

PROFIBUS Slave PROFIBUS Slave Port 

Debug Debug/Configuration 

Port 0 Communication Port 0 

The following illustration shows the pinout for the PROFIBUS Slave port on the 
front of the ProLinx module. 
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3.6.3 Honeywell DE 

Honeywell DE Master modules ship with a special Field Terminal Assembly 
(FTA) module in addition to the ProLinx gateway itself. This module houses the 
physical blocks which devices can be connected to, supporting up to eight 
channels. A special cable is provided to link the FTA to the gateway, as well as 
the necessary screw terminal adapters to wire in your devices. 

Connecting to the FTA 

The module is shipped with a cable and FTA to attach the DE field devices. The 
following illustration shows how to terminate devices to the FTA: 
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3.6.4 Modbus Plus 

Modbus Plus Connections 

The ProLinx module has up to two physical Modbus Plus connectors with up to 
two DB-9 Female plugs located on the front of the module. 

Modicon provides two different Modbus Plus connectors to ease installation. 
These connectors are as follows: 

Modicon Part Number Description 

AS-MBKT-085 Inline Connector 

AS-MBKT-185 Terminating Connector 

The actual cable installation and the wiring of the cable to the connectors is fully 
documented in the Modicon publication Modicon Modbus Plus Network Planning 
and Installation Guide - Pub No. GM-Modbus Plus L-001. 

If the Modicon connectors are not available during installation, the following pin 
out applies to the DB-9 Modbus Plus port connections: 
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3.6.5 HART 

HART modules ship with the necessary screw terminal adapters to connect your 
devices directly to the gateway. 

HART Channels 

The ProLinx module supports the HART protocol as a Master on up to 8 
channels per interface card. Each channel is individually configurable. 

 

The relationship between the port labeling on the front of the ProLinx module and 
the application is as follows: 

Port Label Function 

Debug Debug/configuration 

Port 0 Communications Port 0 

Channel 1 Hart Port 0 

Channel 2 Hart Port 1 

Channel 3 Hart Port 2 

Channel 4 Hart Port 3 

Channel 5 Hart Port 4 

Channel 6 Hart Port 5 

Channel 7 Hart Port 6 

Channel 8 HART Port 7 

The HART protocol uses the Bell 202 standard frequency shift keying (FSK) 
signal to communicate at 1200 baud, superimposed at a low level on the 4 to 20 
mA analog measurement signal. Having an average value of zero, an FSK signal 
causes no interference with the analog value. The HART devices are powered 
from this 4 to 20 mA analog loop. 

All HART protocol channels in the ProLinx module generate the Bell 202 FSK 
signal to communicate in multi-drop mode with up to 15 HART devices and 
provide up to 300 mA supply for the analog loop in multi-drop mode. Refer to the 
Reference chapter for ProLinx HART field connection information. 
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User configured commands determine the HART commands to be issued on 
each channel to the HART devices. Up to 100 commands can be defined for 
each port. Data read from the devices are placed in the virtual database. Any 
write requests or device specific command for the HART slave devices are 
sourced with data from the virtual database or from a configured constant data 
block. In the commands it can be specified whether to use the HART device's 
short or long address. If the long address is selected, the device is polled first 
with short address to ask for the long one. Then the device is polled with the long 
address. The module does all this processing of the address automatically. 

The module can be configured to place slave devices that are not responding to 
commands from the master ports at a lower priority. If the module recognizes that 
a slave device has failed to respond to a message after the user defined retry 
count, it will mark the slave as "in communication failure" and set the error delay 
time to the specified value. Each time that the error delay time expires, the slave 
will be polled and if the answer is successful, the slave is placed again in an 
active status. This facility can improve communication throughput on the HART 
network. 

In a HART network, it is possible to have two masters. The ProLinx module fully 
supports the existence of a second master, but it can reduce the throughput on 
the HART network. This facility is enabled or disabled in the module's 
configuration. If the ability to have a second master on the network is disabled, 
then the maximum throughput is achieved. 

3.6.6 HART Analog 

ProLinx 5108 / 5208 HART Field Connections 

HART field instruments can be connected in multiple ways, depending on power 
requirements and whether the device sinks or sources a bias or operating current 
from the network. 

Connections for HART Analog Point-to-Point Devices 

The ProLinx 5108/5208 HART Analog interface module provides an isolated 24 
VDC power supply output which may be used as a Network Power Supply. It is 
sized for powering one HART Analog transmitter for each of the four HART 
Analog channels. This internal isolated power supply can supply 24VDC @125 
mA max., which is sufficient to supply power to four HART analog transmitters, 
each connected in a point-to-point fashion. Since each HART Analog channel is 
independent and completely isolated, any mixture of loop powered and self 
powered transmitters may be accommodated. External loop power, internal loop 
power or both may be used to power any HART Analog channel. 

WARNING: The 5108/5208 HART Analog module may not be used in multi-drop applications. Only 
one HART transmitter per channel is allowed.  
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Network Power Supply Requirements 

Note: The ProSoft 5108/5208 HART interface may be used with any HART field device transmitter. 

Wiring Diagrams 

If field instrument wiring is shielded, terminate shields at the ground terminals of 
the HART connector TB1. Do not terminate the shields at the instrument. 
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3.6.7 RIO 

A 3 position screw terminal adapter is provided to connect Rockwell Automation 
Remote I/O Adapter devices to the gateway module. 

Remote I/O Adapter Cable Connection 

 

The RIO interface uses the standard Belden 9463 (Blue Hose) cable and is 
terminated as described in the Rockwell Automation Remote I/O documentation. 

No termination resistor is provided on the RIO adapter communication card, 
therefore any necessary termination resistance must be applied via the screw 
terminal connector. 

3.6.8 Wireless 

Antenna Port (6000 Series Modules) 

ProLinx 6000 Series modules provide two RP-SMA connectors, with automatic 
antenna diversity. 
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4 Diagnostics and Troubleshooting 

In This Chapter 

 Requirements ........................................................................................ 59 

 LED Indicators ....................................................................................... 75 

 

There are two ways to troubleshoot ProLinx modules: LEDs located on the front 
of the module, and a Debug port that provides a view into the module's internal 
database. 

4.1 Requirements 

In order to use the Debug capabilities of any ProLinx Module, you will need the 
following: 

 A PC running ProSoft Configuration Builder or HyperTerminal software 
 A Null Modem cable 
 A Mini-DIN to DB-9M connector 
 Configuration and executable files described earlier 

4.1.1 The Configuration/Debug Menu 

The Configuration and Debug menu for this module is arranged as a tree 
structure, with the Main Menu at the top of the tree, and one or more sub-menus 
for each menu command. The first menu you see when you connect to the 
module is the Main menu. 

Because this is a text-based menu system, you enter commands by typing the 
command letter from your computer keyboard in the diagnostic window in 
ProSoft Configuration Builder (PCB). The module does not respond to mouse 
movements or clicks. The command executes as soon as you press the 
command letter — you do not need to press [Enter]. When you type a command 
letter, a new screen will be displayed in your terminal application. 

Required Hardware 

You can connect directly from your computer's serial port to the serial port on the 
module to view configuration information, perform maintenance, and send 
(upload) or receive (download) configuration files. 

ProSoft Technology recommends the following minimum hardware to connect 
your computer to the module: 

 80486 based processor (Pentium preferred) 
 1 megabyte of memory 
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 At least one UART hardware-based serial communications port available. 
USB-based virtual UART systems (USB to serial port adapters) often do not 
function reliably, especially during binary file transfers, such as when 
uploading/downloading configuration files or module firmware upgrades. 

 A null modem serial cable. 

Using the Diagnostic Window in ProSoft Configuration Builder 

To connect to the module's Configuration/Debug serial port: 

1 Start PCB program with the application file to be tested. Right click over the 
module icon. 

 

2 On the shortcut menu, choose Diagnostics. 

 



Diagnostics and Troubleshooting ProLinx ♦ ProLinx Gateways 
 Configuration and Troubleshooting 

 

ProSoft Technology, Inc. Page 61 of 123 
April 14, 2011 
 

3 This action opens the Diagnostics dialog box. Press "?" to display the Main 
Menu. 

 

Important: The illustrations of configuration/debug menus in this section are intended as a general 
guide, and may not exactly match the configuration/debug menus in your own module. 

If there is no response from the module, follow these steps: 

1 Verify that the null modem cable is connected properly between your 
computer's serial port and the module. A regular serial cable will not work. 

2 On computers with more than one serial port, verify that your communication 
program is connected to the same port that is connected to the module. 

If you are still not able to establish a connection, contact ProSoft Technology for 
assistance. 

Navigation 

All of the sub-menus for this module contain commands to redisplay the menu or 
return to the previous menu. You can always return from a sub-menu to the next 
higher menu by pressing [M] on your keyboard. 

The organization of the menu structure is represented in simplified form in the 
following illustration: 
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The remainder of this section shows you the menus available for this module, 
and briefly discusses the commands available to you. 

Keystrokes 

The keyboard commands on these menus are almost always non-case sensitive. 
You can enter most commands in lower case or capital letters. 

The menus use a few special characters ([?], [-], [+], [@]) that must be entered 
exactly as shown. Some of these characters will require you to use the [Shift], 
[Ctrl] or [Alt] keys to enter them correctly. For example, on US English 
keyboards, enter the [?] command as [Shift][/]. 

Also, take care to distinguish capital letter [I] from lower case letter [l] (L) and 
number [1]; likewise for capital letter [O] and number [0]. Although these 
characters look nearly the same on the screen, they perform different actions on 
the module. 

4.1.2 Main Menu 

When you first connect to the module from your computer, your terminal screen 
will be blank. To activate the main menu, press the [?] key on your computer's 
keyboard. If the module is connected properly, the main menu will appear on 
your terminal screen.  

Each ProLinx module shows menu commands appropriate for its specific 
combination of protocols. The following illustration shows the main menu for a 
ProLinx 103M-PDPS module. The main menu for your module will most likely be 
somewhat different.  

 

Caution: Some of the commands available to you from this menu are designed for advanced 
debugging and system testing only, and can cause the module to stop communicating with the 
processor or with other devices, resulting in potential data loss or other failures. Only use these 
commands if you are specifically directed to do so by ProSoft Technology Technical Support staff. 
Some of these command keys are not listed on the menu, but are active nevertheless. Please be 
careful when pressing keys so that you do not accidentally execute an unwanted command. 

Opening the Data Analyzer Menu 

Press [A] to open the Data Analyzer Menu. Use this command to view all bytes 
of data transferred on each port. Both the transmitted and received data bytes 
are displayed. Refer to Data Analyzer for more information about this menu.  
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Important: When in analyzer mode, program execution will slow down. Only use this tool during a 
troubleshooting session. Before disconnecting from the Config/Debug port, please press [S] to stop 
the data analyzer, and then press [M] to return to the main menu. This action will allow the module 
to resume its normal high speed operating mode.  

Opening the Database Menu 

Press [D] to open the Database View menu. Use this menu command to view the 
current contents of the module's database. 

Viewing Block Transfer Statistics 

Press [B] from the Main Menu to view the Block Transfer Statistics screen. 

Use this command to display the configuration and statistics of the backplane 
data transfer operations between the module and the processor. The information 
on this screen can help determine if there are communication problems between 
the processor and the module. 

Tip: To determine the number of blocks transferred each second, mark the numbers displayed at a 
specific time. Then some seconds later activate the command again. Subtract the previous 
numbers from the current numbers and divide by the quantity of seconds passed between the two 
readings. 

Viewing Module Configuration 

Press [C] to view the Module Configuration screen. 

Use this command to display the current configuration and statistics for the 
module. 

Viewing Version Information 

Press [V] to view Version information for the module. 

Use this command to view the current version of the software for the module, as 
well as other important values. You may be asked to provide this information 
when calling for technical support on the product. 

Values at the bottom of the display are important in determining module 
operation. The Program Scan Counter value is incremented each time a 
module's program cycle is complete. 

Tip: Repeat this command at one-second intervals to determine the frequency of program 
execution. 

Viewing Port Communication Status 

Use the Port Communication Status commands to view communication status 
and statistics for the selected port. This information can be informative when 
troubleshooting communication problems.  
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Viewing Port Configuration 

Use the Port Configuration command to display detailed configuration information 
for the selected port.  

Viewing Client Configuration 

Press [B] to display the configuration information for the client.  

Viewing Module Configuration 

Press [C] to view the Module Configuration screen. 

Use this command to display the current configuration and statistics for the 
module. 

Warm Booting the Module 

Caution: Some of the commands available to you from this menu are designed for advanced 
debugging and system testing only, and can cause the module to stop communicating with the 
processor or with other devices, resulting in potential data loss or other failures. Only use these 
commands if you are specifically directed to do so by ProSoft Technology Technical Support staff. 
Some of these command keys are not listed on the menu, but are active nevertheless. Please be 
careful when pressing keys so that you do not accidentally execute an unwanted command. 

Press [W] from the Main Menu to warm boot (restart) the module. This command 
will cause the program to exit and reload, refreshing configuration parameters 
that must be set on program initialization. Only use this command if you must 
force the module to re-boot. 

Exiting the Program 

Caution: Some of the commands available to you from this menu are designed for advanced 
debugging and system testing only, and can cause the module to stop communicating with the 
processor or with other devices, resulting in potential data loss or other failures. Only use these 
commands if you are specifically directed to do so by ProSoft Technology Technical Support staff. 
Some of these command keys are not listed on the menu, but are active nevertheless. Please be 
careful when pressing keys so that you do not accidentally execute an unwanted command. 

Press [Esc] to restart the module and force all drivers to be loaded. The module 
will use the configuration stored in the module's Flash ROM to configure the 
module. 

4.1.3 Data Analyzer 

The data analyzer mode allows you to view all bytes of data transferred on each 
port. Both the transmitted and received data bytes are displayed. Use of this 
feature is limited without a thorough understanding of the protocol. 
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Note: The Port selection commands on the Data Analyzer menu differs very slightly in different 
modules, but the functionality is basically the same. Use the illustration above as a general guide 
only. Refer to the actual data analyzer menu on your module for the specific port commands to 
use. 
Important: When in analyzer mode, program execution will slow down. Only use this tool during a 
troubleshooting session. Before disconnecting from the Config/Debug port, please press [S] to stop 
the data analyzer, and then press [M] to return to the main menu. This action will allow the module 
to resume its normal high speed operating mode.  

Analyzing Data for the application port(s) 

Press the key corresponding to the application port to display I/O data for the 
application port in the Data Analyzer. The following illustration shows an example 
of the Data Analyzer output. 

 

Displaying Timing Marks in the Data Analyzer 

You can display timing marks for a variety of intervals in the data analyzer 
screen. These timing marks can help you determine communication-timing 
characteristics. 

Key Interval 

[5] 1 milliseconds ticks 

[6] 5 milliseconds ticks 

[7] 10 milliseconds ticks 

[8] 50 milliseconds ticks 

[9] 100 milliseconds ticks 

[0] Turn off timing marks 
 

Removing Timing Marks in the Data Analyzer 

Press [0] to turn off timing marks in the Data Analyzer screen. 

Viewing Data in Hexadecimal Format 

Press [H] to display the data on the current page in hexadecimal format. 

Viewing Data in ASCII (Text) Format 

Press [A] to display the data on the current page in ASCII format. This is useful 
for regions of the database that contain ASCII data. 
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Starting the Data Analyzer 

Press [B] to start the data analyzer. After the key is pressed, all data transmitted 
and received on the currently selected port will be displayed. The following 
illustration shows an example. 

 

The Data Analyzer displays the following special characters: 

Character Definition 

[ ] Data enclosed in these characters represent data received on the port. 

< > Data enclosed in these characters represent data transmitted on the port. 

<R+> These characters are inserted when the RTS line is driven high on the port. 

<R-> These characters are inserted when the RTS line is dropped low on the port. 

<CS> These characters are displayed when the CTS line is recognized high. 

_TT_ These characters are displayed when the timing mark interval has been reached. 
This parameter is user defined. 

 

Stopping the Data Analyzer 

Press [S] to stop the data analyzer. Use this option to freeze the display so the 
data can be analyzed. To restart the analyzer, press [B]. 

Important: When in analyzer mode, program execution will slow down. Only use this tool during a 
troubleshooting session. Before disconnecting from the Config/Debug port, please press [S] to stop 
the data analyzer, and then press [M] to return to the main menu. This action will allow the module 
to resume its normal high speed operating mode.  

Returning to the Main Menu 

Press [M] to return to the Main Menu. 
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4.1.4 Data Analyzer Tips 

From the main menu, press [A] for the "Data Analyzer". You should see the 
following text appear on the screen: 

 

After the "Data Analyzer" mode has been selected, press [?] to view the Data 
Analyzer menu. From this menu, you can select the "Port", the "format", and the 
"ticks" that you can display the data in. 

For most applications, HEX is the best format to view the data, and this does 
include ASCII based messages (because some characters will not display on 
HyperTerminal and by capturing the data in HEX, we can figure out what the 
corresponding ASCII characters are supposed to be). 

The Tick value is a timing mark. The module will print a _TT for every xx 
milliseconds of no data on the line. Usually 10milliseconds is the best value to 
start with. 

To save a capture file of your Diagnostics session 

1 After you have selected the Port, Format, and Tick, we are now ready to start 
a capture of this data. Click the Log to File button at the bottom of the 
Diagnostics window. 

 

2 When you have captured the data you want to save, click the Stop Logging 
button. 

 

You have now captured, and saved the file to your PC. This file can now be used 
in analyzing the communications traffic on the line, and assist in determining 
communication errors. 

Now you have everything that shows up on the HyperTerminal screen being 
logged to a file called ProLinxLog.txt. This is the file that you will then be able to 
email to ProSoft Technical Support to assist with issues on the communications 
network. 
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To begin the display of the communications data, you will then want to press 'B' 
to tell the module to start printing the communications traffic out on the debug 
port of the module. After you have pressed 'B', you should see something like the 
following: 

 

The <R+> means that the module is transitioning the communications line to a 
transmit state. 

All characters shown in <> brackets are characters being sent out by the module. 

The <R-> shows when the module is done transmitting data, and is now ready to 
receive information back. 

And finally, all characters shown in the [ ] brackets is information being received 
from another device by the module. 

After taking a minute or two of traffic capture, you will now want to stop the "Data 
Analyzer". To do so, press the 'S' key, and you will then see the scrolling of the 
data stop. 
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4.1.5 Database View Menu 

Press [D] from the Main Menu to open the Database View menu. Use this menu 
command to view the current contents of the module's database. Press [?] to 
view a list of commands available on this menu.  

 

Viewing Register Pages 

To view sets of register pages, use the keys described below: 

Command Description 

[0] Display registers 0 to 99 

[1] Display registers 1000 to 1099 

[2] Display registers 2000 to 2099 

And so on. The total number of register pages available to view depends on your 
module's configuration.  

Displaying the Current Page of Registers Again 

 

This screen displays the current page of 100 registers in the database. 
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Moving Back Through 5 Pages of Registers 

Press [-] from the Database View menu to skip back to the previous 500 
registers of data. 

Viewing the Previous 100 Registers of Data 

Press [P] from the Database View menu to display the previous 100 registers of 
data. 

Skipping 500 Registers of Data 

Hold down [Shift] and press [=] to skip forward to the next 500 registers of data. 

Viewing the Next 100 Registers of Data 

Press [N] from the Database View menu to select and display the next 100 
registers of data. 

Viewing Data in Decimal Format 

Press [D] to display the data on the current page in decimal format. 

Viewing Data in Hexadecimal Format 

Press [H] to display the data on the current page in hexadecimal format. 

Viewing Data in Floating Point Format 

Press [F] from the Database View menu. Use this command to display the data 
on the current page in floating point format. The program assumes that the 
values are aligned on even register boundaries. If floating-point values are not 
aligned as such, they are not displayed properly. 

Viewing Data in ASCII (Text) Format 

Press [A] to display the data on the current page in ASCII format. This is useful 
for regions of the database that contain ASCII data. 

Returning to the Main Menu 

Press [M] to return to the Main Menu. 
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4.1.6 Master Command Error List Menu 

Use this menu to view the command error list for the module. Press [?] to view a 
list of commands available on this menu. 

 

Redisplaying the Current Page 

Press [S] to display the current page of data. 

Viewing the Previous 20 Commands 

Press [-] to display data for the previous 20 commands.  

Viewing the Previous Page of Commands 

Press [P] to display the previous page of commands. 

Viewing the Next 20 Commands 

Press [+] to display data for the next 20 commands.  

Viewing the Next Page of Commands 

Press [N] to display the next page of commands. 

Returning to the Main Menu 

Press [M] to return to the Main Menu. 



ProLinx ♦ ProLinx Gateways Diagnostics and Troubleshooting 
Configuration and Troubleshooting  

 

Page 72 of 123  ProSoft Technology, Inc. 
April 14, 2011 

 

4.1.7 Master Command List Menu 

Use this menu to view the command list for the module. Press [?] to view a list of 
commands available on this menu. 

 

Redisplaying the Current Page 

Press [S] to display the current page of data. 

Viewing the Previous 50 Commands 

Press [-] to view the previous 50 commands.  

Viewing the Previous Page of Commands 

Press [P] to display the previous page of commands. 

Viewing the Next 50 Commands 

Press [+] to view the next 50 commands from the master command list.  

Viewing the Next Page of Commands 

Press [N] to display the next page of commands. 

Returning to the Main Menu 

Press [M] to return to the Main Menu. 
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4.1.8 Network Menu 

The network menu allows you to send, receive and view the WATTCP.CFG file 
that contains the IP and gateway addresses, and other network specification 
information.  

 

Transferring WATTCP.CFG to the module 

Use this command if you are using HyperTerminal to communicate with the 
module, instead of using ProSoft Configuration Builder (the preferred method).  

Press [R] to transfer a new WATTCP.CFG file from the PC to the module. Use 
this command to change the network configuration for the module (for example, 
the module's IP address).  

Press [Y] to confirm the file transfer, and then open the Transfer menu in 
HyperTerminal. On the Transfer menu, choose Send File, and then choose 
Ymodem as the file transfer protocol.  

Transferring WATTCP.CFG to the PC 

Use this command if you are using HyperTerminal to communicate with the 
module, instead of using ProSoft Configuration Builder (the preferred method).  

Press [S] to transfer the WATTCP.CFG file from the module to your PC.  

Press [Y] to confirm the file transfer, and then open the Transfer menu in 
HyperTerminal. On the Transfer menu, choose Receive File, and then choose 
Ymodem as the file transfer protocol.  

After the file has been successfully transferred, you can open and edit the file to 
change the module's network configuration.  
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Viewing the WATTCP.CFG file on the module 

Press [V] to view the module's WATTCP.CFG file. Use this command to confirm 
the module's current network settings.  

 

Returning to the Main Menu 

Press [M] to return to the Main Menu. 

4.1.9 4101 Series Modules 

NOTE: 4101 series modules that use both serial ports (Debug and Port x) as application ports (for 
example, 4101-MCM-DFCM) must be reset or power-cycled in order to enable the selected port as 
a Debug port. To enable the debug port, connect to the port using a null-modem serial cable, and 
then press and hold the [A] key on the keyboard while resetting or power cycling the card. Do not 
release the key until HyperTerminal shows the debug port menu. Debug mode can be enabled on 
either port. The upload/download command is only available when connected to the Debug port.  
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4.2 LED Indicators 

LEDs provide visual indications of potential problems. The following LEDs are 
fundamental to all ProLinx modules. 

4.2.1 Base Module LEDs 
 

LED State Description 

Power Off Power is not connected to the power terminals. This LED is hardware 
driven, so it only requires power to operate. 

Green Solid Power is connected to the power terminals. Verify that the other LEDs 
for operational and functional status. 

Fault Off Normal operation. 

Red Solid A critical error has occurred. Program executable has failed or has 
been user-terminated and is no longer running. Press Reset p/b or 
cycle power to clear error. If not, use the Debug procedures described 
later in this manual. 

Cfg Off Normal operation. 

Amber Solid The unit is in the configuration mode. The configuration file is being 
read and the unit is implementing the configuration values and 
initializing the hardware. This will occur during power cycle, or after 
pressing the reset button. It also occurs after a cold/warm boot 
command is received. 

Err Off Normal operation. 

Amber 
Blinking 

An error condition has been detected and is occurring. Check 
configuration. 

Amber Solid This condition is indicative of a large number of errors in the application 
interface communications. The module's error flag is cleared at the 
start of each command (master/client) or receipt of data 
(slave/adapter/server).  

 

4.2.2 Mini-DIN 8 Serial Port 
 

LED State Description 

ERR Off Normal state. When off and Port Active LED indicates activity, 
there are no communication errors. 

Red Solid or 
Blinking 

Activity on this LED indicates that some communication error 
was detected, either during transmit or receive. To determine 
the exact error, use the Debug port procedures described in 
this section. 

ACT (Active) Off No activity on this port. 

Green Blinking The port is either actively transmitting or receiving data. 
 

4.2.3 Ethernet LED Indicators 
 

LED State Description 

Data Off No activity on the port. 

Green Blinking The port is either actively transmitting or receiving data. 

Link Off No connection to hub or network is detected. 

Green Solid Connected to hub or network correctly. This is the normal 
operating state. 
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4.2.4 PROFIBUS DPV0 Master LED Indicators 
 

LED State Description 

TKN (Token) Green Solid PROFIBUS Master owns token 

RDY (Ready) Off Hardware Error 

Green Solid Normal Operation 

Green cyclic 
blinking,  approx. 
once per second 

Flash only contains boot loader, no valid firmware stored 
in flash. 

Green cyclic 
blinking, approx. four 
times per second 

Hardware or system error or firmware/configuration 
database download in progress. 

ERR Off No errors detected. 

Red Solid Error on communication line. Shows if a bus error has 
occurred, for example, a remote node was not found. 

RUN Green Solid Communication running. 

Green cyclic 
blinking, approx. four 
times per second 

Ready for communication. 

Green acyclic flash Configuration error or fatal error. 
 

4.2.5 PROFIBUS DPV0 Slave LED Indicators 
 

Active LED Error LED Description 

On Off Normal Operation 

Off Off Module not receiving power or program terminated 

Off On Module configured and waiting for first output data set. 

Blinking On PROFIBUS communication problem (not receiving output) 

Off Blinking User timeout expired. 

On Rapid irregular 
blinking 

Configuration problem from master. 

Blinking Together Configuration error during initialization. 

Blinking Alternately Watchdog timer expired. 
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4.2.6 Modbus Plus LED Indicators 
 

LED State Description 

ACT 6 blinks per second The Modbus Plus is working normally in that it is successfully 
receiving and passing the token. All nodes on the link should 
be Blinking in this pattern. 

1 blink per second This node is off-line after just being powered up, or after 
exiting the four blinks per second mode. In this state the 
node monitors the network and builds a table of active nodes 
and token-holding nodes. It remains in this state for five 
seconds, then attempts to go to its normal operating state. 

2 blinks, then Off for 2 
seconds 

The node is hearing the token being passed among other 
nodes, but is never receiving the token. Check the network 
for an open circuit or defective termination. 

3 blinks, then Off for 
1.7 seconds 

The node is not hearing any other nodes. It is periodically 
claiming the token but finding no other node to pass it to. 
Check the network for an open circuit or a defective 
termination. 

4 blinks, then Off for 
1.4 seconds 

The node has heard a valid message from another node that 
is using the same address as this node. The node remains in 
this state as long as it continues to hear the duplicate 
address. If the duplicate address is not heard for five 
seconds, the node then changes to the pattern of one flash 
every second. 

ERR Off Normal State. When the error LED is off and the port is 
actively transferring data, there are no communication errors.

Red Blinking If the LED blinks momentarily, a message error has been 
detected on the cable path. 

Red Solid Either a hard fault has occurred either in the cable or in a 
node device connected to the cable, or none of the 
commands in the Master Command list are successfully 
being completed. 

 

4.2.7 Rockwell Automation Remote I/O LED Indicators 
 

LED State Description 

ACTIVE Off No communication detected on the Remote I/O link. Verify 
connection to scanner, power, and use Debug terminal 
capabilities. 

Green Blinking Remote adapter not actively controlling I/O (Scanner to adapter 
communication link is normal). Verify if the processor is in 
program, or duplicate node address on network. 

Green Solid Normal indication. Remote I/O Adapter is operational. Check 
base module ERR LED to be sure. 
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4.2.8 HART LED Indicators 
 

LED State Description 

CH1 to CH4 Green Blinking The module either sending or receiving data over that 
channel. 

Off The module is waiting to receive data on that channel. 
 

4.2.9 Honeywell DE Master LED Indicators 
 

LED State Description 

ACT Green Solid The module has received data on a channel. Under normal 
operation, this LED should blink rapidly. 

Off The module is waiting to receive data on a channel. 

ERR Red Solid The module is in error or the FTA is not connected. This LED will 
blink when the module is being initialized to indicate module 
activity. Module errors include communication timeout on a 
channel, bad commands, mismatch conditions or hardware 
failure. 

Off Normal Operation. 
 

4.2.10 Wireless Gateway Antenna  LED Indicators 
 

LED Color Description 

RF LINK Off No activity on this port. 

Blinking Green The port is either actively transmitting or receiving data. 

RF DATA Off No activity on this port. 

Blinking Green The port is either actively transmitting or receiving data. 
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4.2.11 4101 Series LEDs 
 

LED State Description 

Power Off Power is not connected to the power terminals. This LED is hardware 
driven, so it only requires power to operate. 

Green Solid Power is connected to the power terminals. Verify that the other LEDs 
for operational and functional status. 

Fault Off Normal operation. 

Red Solid The Debug/Configuration mode is active (applies to modules that 
support pass-through on Debug port - such as DFCM units). 

If CFG LED is not on, a critical error has occurred. Program executable 
has failed or has been user-terminated and is no longer running. Press 
Reset p/b or cycle power to clear error. If not, use the Debug 
procedures described later in this manual. 

CFG Off Normal operation. 

Amber Solid If Fault LED is on, the Debug/Configuration Mode is active (if the 
module supports pass-through on the Debug port - such as DFCM 
units). 

If the Fault LED is off, the unit is in the configuration mode. The 
configuration file is being read and the unit is implementing the 
configuration values and initializing the hardware. This will occur during 
power cycle, or after pressing reset button. It also occurs after a 
cold/warm boot command is received. 

ERR Off Normal operation. 

Blinking An error condition has been detected and is occurring. Check 
configuration. 

Solid Red This condition is indicative of a large number of errors in the application 
interface communications. The module's error flag is cleared at the 
start of each command (master/client) or receipt of data 
(slave/adapter/server).  
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5 Error and Status Data 

In This Chapter 

 Fixed Error and Status Data Register Locations ................................... 82 

 

 

The module error and status data are discussed in this section. Errors are stored 
in individual register addresses within each module. The individual protocol driver 
manuals contain these register addresses and includes tables as to what type of 
error is contained in each register. The protocol driver manuals also contain 
interpretations of the error codes found in specific registers. 

To view individual register content, refer to Opening the Database Menu (page 
63). 

Each driver maintains its error and status data in virtual database registers. In 
order for a protocol driver to use this data, it must be mapped into the module's 
internal database registers (0 to 3999). Data Map Facility describes this process. 
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5.1 Fixed Error and Status Data Register Locations 

In versions 2.20, and later of the ProLinx Gateway products, separate, fixed 
locations have been reserved in upper module memory for error and status 
information for most protocols. Each protocol driver may have a defined set of 
registers associated with its assigned register space; or it may not. 

The chart below shows the memory address areas reserved for status and error 
information from each protocol. Refer to the protocol driver manual for specific 
details of the status information. A few protocols, including DNPM and 101M, do 
not provide status information at this time.  

Driver Description Start Address End Address 

All Drivers Common Module Information 4000 4099 

MBP MODBUS Plus 4100 4399 

MCM Modbus 4400 5999 

MNET Modbus Ethernet 6000 6299 

DFCM DF1 Master/Slave 6300 7899 

DFNT Rockwell Automation EtherNet/IP 7900 8999 

RIO Rockwell Automation Remote I/O adapter 9000 9099 

DNPM DNP 3.0 Master Not available Not available 

DNPS DNP 3.0 Slave 9900 9999 

DNPNET DNP Net Server 10000 10099 

101S IEC-101 Slave 10100 10199 

104S IEC-104 Server 10200 10299 

PDPS PROFIBUS Slave 10300 10399 

PDPM PROFIBUS Master 10400 10499 

 Master Cmds 10500 10699 

HART HART 10700 12299 

BAC BACnet 12300 12499 

Radio Radio Status 12500 12599 

Uconn 
DFNT Client 

Unconnected EtherNet/IP Client 12800 12999 

ASCII Generic Serial 13000 13099 

PDPMV1 PROFIBUS DP V1 Master 13100 13999 

103M IEC-103 Master 14000 14089 

 Master Cmds 15000 15499 

DH485 DH-485 14100 14199 

 Master Cmds 14200 14299 

101M IEC-101 Master Not Available Not Available 

 Master Cmds Not Available Not Available 

MNETC Modbus Ethernet Client 15500 15759 

EGD Ethernet Global Data Exchange Status 16000 17400 

PWP ProSoft Wireless Protocol Exchange Status 18000 19399 

WA-MNET Wireless Modbus TCP/IP 19400 19699 

WA-DFNT Wireless EtherNet/IP 19900 21000 
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5.1.1 Module Status Data Map 

General Module Status Data 

Status Register Description 

4000 Program Cycle Counter 

4001 Product Name (ASCII) = MNET 

4002  

4003 Revision (ASCII) 

4004  

4005 Operating System Rev (ASCII) 

4006  

4007 Production Run Number (ASCII) 

4008  

4009 to 4019 No Valid Data 

HTTP Port 80 Status 

Status Register Description 

4020 Reserved 

4021 Reserved 

4022 Reserved 

4023 Number of Request Packets 

4024 Number of Response Packets 

4025 Reserved 

4026 Reserved 

4027 Reserved 

4028 Reserved 

4029 Reserved 

SNTP Client Status 

Status Register Description 

4030 Time is valid 

4031 Request count 

4032 Response count 

4033 Computation count 

4034 Clock set count 

4035 Timeout error count 

4036 to 4039 No Valid Data 
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Wireless SNTP Client Status 

Status Register Description 

4040 Time is valid 

4041 Request count 

4042 Response count 

4043 Computation count 

4044 Clock set count 

4045 Timeout error count 

4096 to 4049 No Valid Data 
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6 Functional Overview 

In This Chapter 

 Internal Database .................................................................................. 85 

 

 

ProLinx communication gateway modules allow devices with different protocols 
to communicate with each other. The available drivers act as Masters (clients in 
Ethernet), Slaves (servers in Ethernet), and in some cases peers on their 
respective communication networks. 

6.1 Internal Database 

Central to the functionality of the module is the internal database. This database 
is shared between all ports on the module and is used as a conduit to pass 
information from one device on one network to one or more devices on another 
network. This permits data from devices on one communication port to be viewed 
and controlled by devices on another port. 
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In addition to data from the slave and master ports, status and error information 
generated by the module can also be mapped into the internal database. 

6.1.1 Protocol Driver Access to the Database 

Master/Client drivers use the database in two ways: 

 A Read Command issued to a slave/server device by the Master/Client driver 
will return the slave/server data to the internal database. 

 A Write Command issued to a slave/server by the Master/Client driver uses 
the data in the internal database to write to the slave/server device. 

Slave/server drivers access data from the internal database. External 
Master/Client devices can monitor and control data in this database through 
these slave/server ports. Setup of the slave/server ports only requires a .cfg file. 

6.1.2 [Data Map] 

The [Data Map] section of the CFG file allows you to selectively copy data 
registers, one register up to 100 registers at a time, from one internal database 
area to another. Up to 200 entries can be made in the [Data Map] section, 
providing a wide and powerful range of functionality. 

You can use the Data Map section of the configuration file to copy data from the 
device error or status table to the internal database register, or to copy data from 
one area to another. The bytes and/or words copied can be altered to preset the 
data (for example, floating-point data) in the correct format for a specific protocol. 
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You can also use the Data Map to build a specific block of data to be used by 
any of the protocol drivers. For example, you can use the data map to build the 
input and output data area for the PROFIBUS Slave driver. 

 

 

From Address 

0 to highest Status Data address 

This field specifies the internal database register to copy from. This address can 
range from the Data area as well as the Status Data Area of the product  

To Address 

0 to 3999 

The destination for the copy is always within the Register Data area. 
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Register Count 

1 to 100 

This parameter specifies the number of registers to copy.  

Swap Code 

0,1,2,3 

You may need to swap the order of the bytes in the registers during the copy 
process in order to change from alignment of bytes between dissimilar protocols. 
This parameter is helpful when dealing with floating-point or other multi-register 
values, as there is no standard method of storage of these data types in slave 
devices.  

The following table defines the values and their associated operations: 

 

Swap Code Description 

0 None: No Change is made in the byte ordering (1234 = 1234) 

1 Words: The words are swapped (1234=3412) 

2 Words & Bytes: The words are swapped then the bytes in each word are 
swapped (1234=4321) 

3 Bytes: The bytes in each word are swapped (1234=2143) 

Delay Preset 

Copies one portion of the database or virtual database to a user specified 
location in the database. The Delay Preset represents the scan count of the 
program between each copy operation. The copy operations should not all 
happen at the same time, otherwise the process could delay the scan. For 
example, you should not set all values to a delay preset of 1001. Instead, use 
values such as 1000, 1001 and 1002, or you can use the preset values. This will 
keep the copies from happening concurrently.  
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7 Reference 

In This Chapter 

 Product Specifications ........................................................................... 89 

 Editing and Downloading CFG Files using NotePad and HyperTerminal93 

 

7.1 Product Specifications 

ProLinx Communication Gateways are the ideal solution for bridging 
communication between networks that use differing protocols. ProLinx modules 
provide several protocol combinations, allowing for a wide range of flexibility in 
establishing a network, or fitting into and expanding your current infrastructure. 
Coupled with ProSoft's radio technology, you can easily integrate devices into 
your system wirelessly, and without the need to purchase additional radios to do 
so. 

7.1.1 General Specifications 

The ProLinx Communication Modules provide connectivity for two or more 
dissimilar network types. The modules, encased in sturdy extruded aluminum, 
are stand-alone DIN-rail mounted protocol gateways, providing communication 
between many of the most widely used protocols in industrial automation today. 

7.1.2 General Specifications - Radio Modules 

These modules utilize a full function wireless network card, supporting RF data 
rates up to 11 Mbps. The modules function as a client, providing an ultra-fast 
wireless solution for the most demanding industrial applications. 

These modules allow you to connect various field devices using different 
networks or protocols and share data between these devices "over-the-air." This 
is accomplished by exchanging shared common database information over-the-
air with ProSoft Technology's efficient but powerful wireless protocol. 
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General Radio Specifications 

Specification Value 

Frequency 2.4 GHz band (2400 to 2483.5 MHz)* 

Wireless medium DSSS: Direct Sequence Spread Spectrum (802.11 b) 

Output power 32 mW (15 dBm) 

Channel data rates 11, 5.5, 2, 1 Mbps 

Channels: user selectable 11: North America 

13: Europe** 

14: Japan 

Security PWP + WEP 64/128 Encryption with WEP key rollover 
management 

Antenna Ports Two RP-SMA connectors, automatic antenna diversity 

Bit Error Rate (BER) Better than 10-5 

 

Range / Transmit 
Rate 

High Speed 
11 Mbps 

Medium Speed 
5.5 Mbps 

Standard Speed 
2 Mbps 

Low Speed 
1 Mbps 

Open Office 
Environment 

160m 
(525 ft.) 

270 m 
(885 ft.) 

400 m 
(1300 ft.) 

550 m 
(1750 ft) 

Semi-Open Office 
Environment 

50 m 
(165 ft.) 

70 m 
(230 ft.) 

90 m 
(300 ft.) 

115 m 
(375 ft.) 

Closed Office 25 m 
(80 ft.) 

35 m 
(115 ft.) 

40 m 
(130 ft.) 

50 m 
(165 ft) 

Receiver Sensitivity -83 dBm -87 dBm -91 dBm -94 dBm 

* Varies with country regulation 
** Some European countries such as France allow fewer channels 

7.1.3 Internal Database 

The ProLinx module contains an internal database that consists of areas for 
application data, status information, and configuration information. 

The internal database is shared between all ports on the module and is used as 
a conduit to pass information from a device on one network to one or more 
devices on another network. 

Application Data Area 

The data area stores and retrieve data by the protocol drivers and for data 
exchange between protocols. The database is used as a source for write 
commands to remote devices and holds data collected from the remote devices. 
Commands defined in the configuration file (stored in the configuration data area) 
control how the data is to be handled in the database. 

Status Data Area 

This area stores error codes, counters, and port status information for each port. 
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Configuration File 

This file contains module configuration information such as port configuration, 
network information, and command configuration. This configuration file is 
transferred to or from the module. 

Optional Web Server for Ethernet Solutions 

An HTML server is available for Ethernet ProLinx modules. With this option, 
HTML text pages can be enabled to: 

 Display module internal register and status values 
 Accept user data input values via POST commands for setpoint, on/off 

control, etc. 
 Provide limited graphic file support 
 

Type Specifications 

HTML Server (See note 
below) 

Key features of the HTML server include: 
Max HTML page size: 1MB 
Max File Storage: 32MB 
Supported context types: jpeg, bmp, css 
Supported data types: bit, ASCII, integer, float 
Sockets: Up to five connections. Note that this limits the number of 
simultaneous graphic file and frame references per HTML page 

FTP Server Permits remote HTML file transfer between the module and remote 
host. Capabilities of the FTP Server include: 
Single socket connection 
Non-passive transfers only 
WS_FTP or Command Line FTP recommended 
CuteFTP, Internet Explorer, Netscape, or NCFTP all support multiple 
socket connections and therefore are not supported by the ProLinx 
module 

Email Client E-mail message generation based on database trigger values. 
Messages can contain dynamic data from the module 

Important Note: The Web Server is not designed to act like, or replace, the powerful web servers 
available in the marketplace today. Please check application specifics with Technical Support if you 
are unsure if your application will work with the ProLinx Web Server. 
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7.1.4 Hardware Specifications 

Specification Description 

Power Supply 24 VDC nominal 
18 to 32 VDC allowed 
Positive, Negative, GND Terminals 
2.5 mm screwdriver blade 

Current Load 500 mA max@ 32 VDC max  

Operating Temperature -20 to 50°C (-4 to 122°F) 

Storage Temperature -40 to 85°C (-40 to 185°F)  

Relative Humidity 5% to 95% (non-condensing) 

Dimensions Standard: 5.20H x 2.07W x 4.52D in. (13.2cmH x 5.25cmW x 
11.48cmD) 
Extended: 5.20H x 2.73W x 4.52D in. (13.2cmH x 6.934cmW x 
11.48cmD) 

LED Indicators Power and Module Status 
Application Status 
Serial Port Activity LED 
Serial Activity and Error LED Status 

Configuration Serial Port DB-9M RS-232 only 
No hardware handshaking  

Ethernet Port (Ethernet 
modules only) 

10Base-T RJ45 Connector 
Link and Activity LED indicators 
Electrical Isolation 1500 V rms at 50 Hz to 60 Hz for 60 s, applied as 
specified in section 5.3.2 of IEC 60950: 1991 
Ethernet Broadcast Storm Resiliency = less than or equal to 5000 
[ARP] frames-per-second and less than or equal to 5 minutes 
duration 

Application Serial Ports RS-232/422/485 
RS-232 handshaking configurable 
RS-422/485 screw termination included 

Serial Port Isolation 2500V RMS port signal isolation per UL 1577 
3000V DC min. port to ground and port to logic power isolation 

Shipped with Each Unit Mini-DIN to DB-9M serial cables  
4 ft RS-232 configuration cable 
2.5mm screwdriver 
CD (docs and Configuration utility) 
RS-422/485 DB-9 to Screw Terminal Adaptor (1 or 4, depending on 
ports) 

Example Interconnect Cable 
Types 

Rockwell Automation RIO and DH+ protocols use Belden 9463 type 
shielded cable or equivalent. Schneider Electric Modbus Plus 
protocol uses Belden 9841 type shielded cable or equivalent. 
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7.1.5 ProSoft Configuration Builder 

ProSoft Configuration Builder (PCB) provides a quick and easy way to manage 
module configuration files customized to meet your application needs. PCB is not 
only a powerful solution for new configuration files, but also allows you to import 
information from previously installed (known working) configurations to new 
projects.  
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7.2 Editing and Downloading CFG Files using NotePad and 
HyperTerminal 

Important: The following topics describe how to connect to the ProLinx module with 
HyperTerminal, and how to edit configuration files with NotePad. In most cases, you will use 
ProSoft Configuration Builder to manage your ProLinx configuration files. You should only use 
these procedures if you are directed to do so by ProSoft Technical Services.  

ProLinx modules are shipped with a default configuration file, executable files, 
and if required, a wattcp.cfg file. 

Configuration and executable file updates are found on the ProSoft web site at 
http://www.prosoft-technology.com 

7.2.1 Determining the Version of Your ProLinx Module 

You can check the version of your module two ways; first by looking at the sticker 
on the back of the module. Or, you can check the version through the version 
menu item using the Module Program Loader.  

To view version information through the Loader: 

1 Connect to the module using HyperTerminal, and then turn power off to the 
module.  

2 With HyperTerminal open, restore power to the module while holding down 
the [L] key on your keyboard. This action causes the module to run a special 
utility program that provides basic version information, file transfers and 
upgrade tools.  

3 After a few moments, the Loader screen will appear. The Loader screen for 
your module will be similar but not necessarily identical to the following 
illustration.  
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4 Press the [V] key on your keyboard to see the Version Information screen. 
The Version Information screen for your module will be similar but not 
necessarily identical to the following illustration.  

 

Important: Download procedures for ProLinx modules older than version 2.4 are listed at the end 
of this section. If your ProLinx module is an older version, please contact ProSoft Technical 
Services for upgrade instructions.  
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7.2.2 Overview and Purpose of the Configuration File 

All configuration information for the module is stored in a text file with a user-
defined name. Examples include: 

 4201-DFNT-DFCM: DFNTDFCM.CFG 
 4204-RIO-MCM: RIOMCM.CFG 
 PUMP1.CFG 
 STAT101.CFG 

The CFG file contains the configuration for the internal database, the port 
communication parameters, and the command list data for the master ports. 

All modules ship with an example CFG file stored directly in the module and 
should be used as a starting point for configuration. A file is also available from 
the ProSoft web site at http://www.prosoft-technology.com. You can update this 
file using any text editor to edit data in the file. 

When you are finished editing the file, download to the module using a terminal 
emulation program as described in the following sections. 

7.2.3 CFG File Structure 

The CFG file is separated into several sections with topic header names 
enclosed in the [ ] bracket characters. As an example, the sections present in the 
configuration file are as follows: 

[SECTION] Description 

[Module] Contains general module configuration information. 

[RIO] Configuration data for remote I/O interface 

[Port 0 Modbus] Configuration data for Modbus Port 0 

[Port 0 Commands] Command list for Port 0 Modbus Master 

The following sections are only required if using the multiple serial protocol port 
unit (MCM4 unit): 

[SECTION] Description 

[Port 1 Modbus] Configuration data for Modbus Port 1 

[Port 1 Commands] Command list for Port 1 Modbus Master 

[Port 2 Modbus] Configuration data for Modbus Port 2 

[Port 2 Commands] Command List for Port 2 Modbus Master 

[Port 3 Modbus] Configuration data for Modbus Port 3 

[Port 3 Commands] Command list for Port 3 Modbus Master 
 

[MODULE] 

The [Module] section of the CFG file is used to set the module's name. Each 
ProLinx Protocol Manual provides a sample configuration file followed by a 
descriptive table of each section of the file. 
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7.2.4 Editing Configuration Files 

In order to understand each of the parameters contained within the configuration 
file, you should refer to the specific protocol manual for the module you are 
attempting to change. 

1 Choose Start  Programs  Accessories  Notepad.  
2 In Notepad, choose File  Open. 

The Open dialog appears. 

3 Browse to the configuration file on your PC and select it. Click Open. The 
configuration file appears in Notepad, ready for editing. 

 

4 Edit the Sample Configuration File Sections. 
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Comment Records and Editing Hints 

Any record that begins with the # character is considered a comment record. 
These records may be placed anywhere in the file as long as the # character is 
found in the first column of the line. All comment lines are ignored in the file and 
may be used to provide documentation within the configuration file. Liberal use of 
comments within the file can ease the use and interpretation of the data in the 
file. 

A set of parameters follows each section header. Unique labels are used under 
each section to specify a parameter. Each label in the file must be entered 
exactly as shown in the file for the parameter to be identified by the program. If 
the module is not accepting a parameter, check the label for the data item. Each 
parameter's value is separated from the label with the [:] character. This 
character is used to delimit the position in the record where reading is to start. All 
data for a parameter must be placed after the [:] character. 

For numeric parameter values, any text located after the value will not be used. 
There must be at least one space character between the end of the parameter 
value and the following text. 

Important notes to consider when editing the sample configuration file: 

 Comments within the file are preceded by the pound (#) sign. Any text on a 
line that occurs after the # character will be ignored. 

 Do not use tabs or other non-printing characters instead of spaces to 
separate parameters (spacebar). 

Parameter names must begin in the first column of a line, and may not be 
preceded with a space (spacebar) or other non-printing character.  

When all edits are complete, you should save the updated file to a location on 
your hard drive before following the instructions on how to download the 
configuration file to the ProLinx module. 
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7.2.5 Backing Up Existing Files (Version 2.4 Modules) 

Before performing this procedure, make sure to check the version of your 
module. This procedure is designed for module versions 2.4 or above. All 
modules should be upgraded to Version 2.4. If you have not already upgraded 
your module, please contact ProSoft Technical Services for instructions. 

Performing this procedure is only required if you do not have a copy of the 
module's configuration file (and wattcp.cfg/web files for Ethernet modules) on 
your PC. 

The following procedure describes how to back up these files. Make sure your 
computer is connected to the module's Configuration/Debug port as shown using 
a Null Modem cable and ProLinx Adapter Cable. 
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Uploading the Configuration from the Module to Your PC 

Perform the following steps to upload the module's configuration file to your PC: 

1 Start HyperTerminal on your PC. The Connection Description window 
appears. 

Note: This document uses HyperTerminal in all examples. 

 

2 Type a name in the Name field and click OK. The Connect To window 
appears. 
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3 Choose the COM Port that your ProLinx module is connected to and click 
OK. The COM1 Properties window opens. 

 

4 Set the following parameters: 
 

Bits per second 57600 

Data bits 8 

Parity None 

Stop bits 1 

Flow control Xon/Xoff 

5 Click OK. The HyperTerminal window opens and displays a blinking cursor. 
6 Press the [?] key to display the Loader Menu. 
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Note: The following screen is an example Loader menu. Your screen may look slightly different 
depending on what application you run. However, the procedure is the same for all modules. 

 

7 Type [S] and press Enter. 
8 Type [Y] when the prompt appears. 
9 The message: 

"TRANSFERRING CONFIGURATION FILE FROM UNIT TO REMOTE:" 

appears. 

10 Choose the Transfer menu option at the top of the HyperTerminal window, 
then choose Receive File. 

11 The Receive File window opens. 
12 Navigate to the directory where you want to store the uploaded file. Make 

sure Ymodem is selected as the protocol. 
13 Click Receive. 
14 This uploads the .cfg file to the PC. When the upload is complete, the 

message "FILE TRANSFERRED TO REMOTE UNIT" appears. 
15 The Module Configuration information appears. To return to the Module 

Menu, press the [?] key. 

Uploading the WATTCP.CFG File (Modules with an Ethernet Port) 

To upload the WATTCP.CFG file to your PC, use the same upload procedure 
described in the previous section but first press [@] from the Main Menu to open 
the Network menu. 
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7.2.6 Downloading Files to a Version 2.4 Module 

The procedure described in this section pertains to Version 2.4 and newer 
modules only. 

1 Connect your PC's COM port to the ProLinx Configuration/Debug port using 
the Null Modem cable and ProLinx Adapter cable. 

2 From the Start Menu on your PC, select Programs  Accessories  
Communications  HyperTerminal. The New Connection Screen appears: 

 

3 Enter a name and choose OK. The Connect To window appears: 
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4 Choose the COM port that your ProLinx module is connected to and choose 
OK. The COM1 Properties window appears. 

 

5 Ensure that the settings shown on this screen match those on your PC. 
6 Click OK. The HyperTerminal window appears with a DOS prompt and 

blinking cursor. 
7 Apply power to the ProLinx module and hold down the [L] key. The screen 

displays information and ultimately displays the Loader menu: 
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This menu provides options that allow you to download a configuration file [C], a 
WATTCP file [W], or a new executable file [U]. You can also press [V] to view 
module version information. 

1 Type [C] at the prompt to transfer files from the computer to the ProLinx unit. 
2 Type [Y] when the program asks if you want to load a .cfg file. 
3 From the HyperTerminal menu, select Transfer Send. 

 

4 When the Send To screen appears, browse for the configuration file that you 
downloaded from the web or backed up from your unit. Be sure to select Y 
Modem in the Protocol field. 

 

Note: The configuration file downloaded from the web is a default configuration file. You will have 
to update this configuration file. Therefore, if you backed up your module's configuration file to a 
location on your hard drive, make sure you select your backed up configuration file and not the 
configuration file downloaded from the web. 

5 Click Send. The program loads the new configuration file to the ProLinx 
module. When the download is complete, the program returns to the Loader 
menu. 

If you want to load a new executable file or a WATTCP file, select the 
appropriate option and perform the same steps to download these files. 

6 Press [Esc], then [Y] to confirm module reboot. 
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7.2.7 Download Procedure for Version 2.2 Modules 

Important! These procedures are provided for customers who have not yet upgraded to Version 
2.4. However, you should perform the upgrade as soon as possible. Contact ProSoft Technical 
Services for instructions to upgrade your ProLinx module. 

Making the Required Connections 

Ensure that all of the required connections are made and secure. The following 
diagram illustrates the appropriate connections: 

 

The Null modem cable connects to the serial port (for example COM1) of a PC 
running a terminal emulation program, while the other end plugs into the DB-9M 
connector. The other end of the DB-9M connector plugs into the Debug port of 
the ProLinx module. 

Uploading and Downloading Configuration Files 

This section describes how to upload a configuration file from a ProLinx module 
to a PC for editing, and how to download the edited file from a PC to the ProLinx 
module. 

At this point, you should have the module connected to a PC. 
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Uploading the Configuration from the Module to Your PC. 

Perform the following steps to upload the module's configuration file to your PC: 

1 Start HyperTerminal on your PC. The Connection Description window 
appears. 

Note: This document uses HyperTerminal in all examples. 

 

2 Type a name in the Name field and click OK. The Connect To window 
appears. 
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3 Choose the COM Port that your ProLinx module is connected to and click 
OK. The COM1 Properties window opens. 

 

4 Set the following parameters: 

Bits per second 57600 

Data bits 8 

Parity None 

Stop bits 1 

Flow control Xon/Xoff 

5 Click OK. The HyperTerminal window opens and displays a blinking cursor. 
6 Press the [?] key to display the Module Menu. 

 

7 Type [S] and press Enter. 
8 Type [Y] when the prompt appears. 

The message: 

"TRANSFERRING CONFIGURATION FILE FROM UNIT TO REMOTE:" 

appears. 
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9 Choose the Transfer menu option at the top of the HyperTerminal window, 
then choose Receive File. 

10 The Receive File window opens. 
11 Select the directory where you want to store the uploaded file. 
12 Click Open. 
13 This uploads the .cfg file to the PC. When the upload is complete, the 

message "FILE TRANSFERRED TO REMOTE UNIT" appears. 
14 The Module Configuration information appears. To return to the Module 

Menu, press the [?] key. 

Uploading the WATTCP.CFG File (Modules with an Ethernet Port) 

If you are using an Ethernet module, you may want to modify the default 
WATTCP.CFG file located on the module. Section 7 provides information on how 
to modify the WATTCP.CFG file and also provides instructions on how to 
download it back to the module. 

To upload the WATTCP.CFG file to your PC, use the same upload procedure 
described in the previous section but first press [@] from the Main Menu to open 
the Network menu. 

Downloading the Configuration File from Your PC to the Module 

Perform the following steps to download the configuration file: 

1 Start HyperTerminal on your PC. The Connection Description window 
appears. 

Note: This document uses HyperTerminal in all examples. 
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2 Type a name in the Name field and click OK. The Connect To window 
appears. 

 

3 Choose the COM Port that your ProLinx module is connected to and click 
OK. The COM1 Properties window opens. 

 

4 Set the following parameters: 

Bits per second 57600 

Data bits 8 

Parity None 

Stop bits 1 

Flow control Xon/Xoff 

5 Click OK. The HyperTerminal window opens and displays a blinking cursor. 
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6 Press the [?] key to display the Module Menu. 

 

7 Type [R] and press Enter. 
8 Type [Y] to confirm configuration receive. 

The message: 

"TRANSFERRING FILE FROM COMPUTER TO PROLINX UNIT: 
Send the Configuration file now!" 

appears. 

9 Choose the Transfer menu option at the top of the HyperTerminal window, 
then choose Send File. 

10 The Select File to Send Window opens. 
11 Locate the directory where you stored the edited files. 
12 Select the file and click Open. 
13 This downloads the .cfg file to the ProLinx module. When the download is 

complete, the message "FILE TRANSFERRED FROM REMOTE UNIT" 
appears. The module displays configuration information. Press the [?] key to 
return to the Module Menu. 
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8 Support, Service & Warranty 

In This Chapter 

 How to Contact Us: Technical Support ................................................ 114 

 Return Material Authorization (RMA) Policies and Conditions ............. 114 

 LIMITED WARRANTY ......................................................................... 116 

 

 

ProSoft Technology, Inc. (ProSoft) is committed to providing the most efficient 
and effective support possible. Before calling, please gather the following 
information to assist in expediting this process: 

1 Product Version Number 
2 System architecture 
3 Network details 

If the issue is hardware related, we will also need information regarding: 

1 Module configuration and contents of file 

o Module Operation 
o Configuration/Debug status information 
o LED patterns 

2 Information about the processor and user data files as viewed through and 
LED patterns on the processor. 

3 Details about the serial devices interfaced, if any. 
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8.1 How to Contact Us: Technical Support 

Internet Web Site: http://www.prosoft-technology.com/support 

E-mail address: support@prosoft-technology.com 

Asia Pacific 

+603.7724.2080, support.asia@prosoft-technology.com 
Languages spoken include: Chinese, English 

Europe (location in Toulouse, France) 

+33 (0) 5.34.36.87.20, support.EMEA@prosoft-technology.com 
Languages spoken include: French, English 

North America/Latin America (excluding Brasil) (location in California) 

+1.661.716.5100, support@prosoft-technology.com 
Languages spoken include: English, Spanish 
For technical support calls within the United States, an after-hours answering system allows pager 
access to one of our qualified technical and/or application support engineers at any time to answer 
your questions. 

Brasil (location in Sao Paulo) 

+55-11-5084-5178 , eduardo@prosoft-technology.com 
Languages spoken include: Portuguese, English 

8.2 Return Material Authorization (RMA) Policies and Conditions 

The following RMA Policies and Conditions (collectively, "RMA Policies") apply to 
any returned Product. These RMA Policies are subject to change by ProSoft 
without notice. For warranty information, see "Limited Warranty". In the event of 
any inconsistency between the RMA Policies and the Warranty, the Warranty 
shall govern.  

8.2.1 All Product Returns: 

a) In order to return a Product for repair, exchange or otherwise, the 
Customer must obtain a Returned Material Authorization (RMA) number 
from ProSoft and comply with ProSoft shipping instructions. 

b) In the event that the Customer experiences a problem with the Product for 
any reason, Customer should contact ProSoft Technical Support at one of 
the telephone numbers listed above (page 114). A Technical Support 
Engineer will request that you perform several tests in an attempt to 
isolate the problem. If after completing these tests, the Product is found to 
be the source of the problem, we will issue an RMA. 

c) All returned Products must be shipped freight prepaid, in the original 
shipping container or equivalent, to the location specified by ProSoft, and 
be accompanied by proof of purchase and receipt date. The RMA number 
is to be prominently marked on the outside of the shipping box. Customer 
agrees to insure the Product or assume the risk of loss or damage in 
transit. Products shipped to ProSoft using a shipment method other than 
that specified by ProSoft or shipped without an RMA number will be 
returned to the Customer, freight collect. Contact ProSoft Technical 
Support for further information. 

d) A 10% restocking fee applies to all warranty credit returns whereby a 
Customer has an application change, ordered too many, does not need, 
etc. 
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8.2.2 Procedures for Return of Units Under Warranty: 

A Technical Support Engineer must approve the return of Product under 
ProSoft's Warranty: 

a) A replacement module will be shipped and invoiced. A purchase order will 
be required. 

b) Credit for a product under warranty will be issued upon receipt of 
authorized product by ProSoft at designated location referenced on the 
Return Material Authorization. 

8.2.3 Procedures for Return of Units Out of Warranty: 

a) Customer sends unit in for evaluation 
b) If no defect is found, Customer will be charged the equivalent of $100 

USD, plus freight charges, duties and taxes as applicable. A new 
purchase order will be required. 

c) If unit is repaired, charge to Customer will be 30% of current list price 
(USD) plus freight charges, duties and taxes as applicable. A new 
purchase order will be required or authorization to use the purchase order 
submitted for evaluation fee.  

The following is a list of non-repairable units: 

o 3150 - All 
o 3750 
o 3600 - All 
o 3700 
o 3170 - All 
o 3250 
o 1560 - Can be repaired, only if defect is the power supply 
o 1550 - Can be repaired, only if defect is the power supply 
o 3350 
o 3300 
o 1500 - All 

8.2.4 Purchasing Warranty Extension: 

a) ProSoft's standard warranty period is three (3) years from the date of 
shipment as detailed in "Limited Warranty (page 116)". The Warranty 
Period may be extended at the time of equipment purchase for an 
additional charge, as follows: 

 Additional 1 year = 10% of list price 
 Additional 2 years = 20% of list price 
 Additional 3 years = 30% of list price 
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8.3 LIMITED WARRANTY 

This Limited Warranty ("Warranty") governs all sales of hardware, software and 
other products (collectively, "Product") manufactured and/or offered for sale by 
ProSoft, and all related services provided by ProSoft, including maintenance, 
repair, warranty exchange, and service programs (collectively, "Services"). By 
purchasing or using the Product or Services, the individual or entity purchasing or 
using the Product or Services ("Customer") agrees to all of the terms and 
provisions (collectively, the "Terms") of this Limited Warranty. All sales of 
software or other intellectual property are, in addition, subject to any license 
agreement accompanying such software or other intellectual property. 

8.3.1 What Is Covered By This Warranty 

a) Warranty On New Products: ProSoft warrants, to the original purchaser, 
that the Product that is the subject of the sale will (1) conform to and 
perform in accordance with published specifications prepared, approved 
and issued by ProSoft, and (2) will be free from defects in material or 
workmanship; provided these warranties only cover Product that is sold as 
new. This Warranty expires three years from the date of shipment (the 
"Warranty Period"). If the Customer discovers within the Warranty Period 
a failure of the Product to conform to specifications, or a defect in material 
or workmanship of the Product, the Customer must promptly notify 
ProSoft by fax, email or telephone. In no event may that notification be 
received by ProSoft later than 39 months. Within a reasonable time after 
notification, ProSoft will correct any failure of the Product to conform to 
specifications or any defect in material or workmanship of the Product, 
with either new or used replacement parts. Such repair, including both 
parts and labor, will be performed at ProSoft's expense. All warranty 
service will be performed at service centers designated by ProSoft. 

b) Warranty On Services: Materials and labor performed by ProSoft to repair 
a verified malfunction or defect are warranteed in the terms specified 
above for new Product, provided said warranty will be for the period 
remaining on the original new equipment warranty or, if the original 
warranty is no longer in effect, for a period of 90 days from the date of 
repair. 

8.3.2 What Is Not Covered By This Warranty 

a) ProSoft makes no representation or warranty, expressed or implied, that 
the operation of software purchased from ProSoft will be uninterrupted or 
error free or that the functions contained in the software will meet or 
satisfy the purchaser's intended use or requirements; the Customer 
assumes complete responsibility for decisions made or actions taken 
based on information obtained using ProSoft software. 
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b) This Warranty does not cover the failure of the Product to perform 
specified functions, or any other non-conformance, defects, losses or 
damages caused by or attributable to any of the following: (i) shipping; (ii) 
improper installation or other failure of Customer to adhere to ProSoft's 
specifications or instructions; (iii) unauthorized repair or maintenance; (iv) 
attachments, equipment, options, parts, software, or user-created 
programming (including, but not limited to, programs developed with any 
IEC 61131-3, "C" or any variant of "C" programming languages) not 
furnished by ProSoft; (v) use of the Product for purposes other than those 
for which it was designed; (vi) any other abuse, misapplication, neglect or 
misuse by the Customer; (vii) accident, improper testing or causes 
external to the Product such as, but not limited to, exposure to extremes 
of temperature or humidity, power failure or power surges; or (viii) 
disasters such as fire, flood, earthquake, wind and lightning. 

c) The information in this Agreement is subject to change without notice. 
ProSoft shall not be liable for technical or editorial errors or omissions 
made herein; nor for incidental or consequential damages resulting from 
the furnishing, performance or use of this material. The user guide 
included with your original product purchase from ProSoft contains 
information protected by copyright. No part of the guide may be duplicated 
or reproduced in any form without prior written consent from ProSoft. 

8.3.3 Disclaimer Regarding High Risk Activities 

Product manufactured or supplied by ProSoft is not fault tolerant and is not 
designed, manufactured or intended for use in hazardous environments requiring 
fail-safe performance including and without limitation: the operation of nuclear 
facilities, aircraft navigation of communication systems, air traffic control, direct 
life support machines or weapons systems in which the failure of the product 
could lead directly or indirectly to death, personal injury or severe physical or 
environmental damage (collectively, "high risk activities"). ProSoft specifically 
disclaims any express or implied warranty of fitness for high risk activities. 

8.3.4 Intellectual Property Indemnity 

Buyer shall indemnify and hold harmless ProSoft and its employees from and 
against all liabilities, losses, claims, costs and expenses (including attorney's 
fees and expenses) related to any claim, investigation, litigation or proceeding 
(whether or not ProSoft is a party) which arises or is alleged to arise from Buyer's 
acts or omissions under these Terms or in any way with respect to the Products. 
Without limiting the foregoing, Buyer (at its own expense) shall indemnify and 
hold harmless ProSoft and defend or settle any action brought against such 
Companies to the extent based on a claim that any Product made to Buyer 
specifications infringed intellectual property rights of another party. ProSoft 
makes no warranty that the product is or will be delivered free of any person's 
claiming of patent, trademark, or similar infringement. The Buyer assumes all 
risks (including the risk of suit) that the product or any use of the product will 
infringe existing or subsequently issued patents, trademarks, or copyrights. 
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a) Any documentation included with Product purchased from ProSoft is 
protected by copyright and may not be duplicated or reproduced in any 
form without prior written consent from ProSoft. 

b) ProSoft's technical specifications and documentation that are included 
with the Product are subject to editing and modification without notice. 

c) Transfer of title shall not operate to convey to Customer any right to make, 
or have made, any Product supplied by ProSoft. 

d) Customer is granted no right or license to use any software or other 
intellectual property in any manner or for any purpose not expressly 
permitted by any license agreement accompanying such software or other 
intellectual property. 

e) Customer agrees that it shall not, and shall not authorize others to, copy 
software provided by ProSoft (except as expressly permitted in any 
license agreement accompanying such software); transfer software to a 
third party separately from the Product; modify, alter, translate, decode, 
decompile, disassemble, reverse-engineer or otherwise attempt to derive 
the source code of the software or create derivative works based on the 
software; export the software or underlying technology in contravention of 
applicable US and international export laws and regulations; or use the 
software other than as authorized in connection with use of Product. 

f) Additional Restrictions Relating To Software And Other Intellectual 
Property 

In addition to compliance with the Terms of this Warranty, Customers 
purchasing software or other intellectual property shall comply with any 
license agreement accompanying such software or other intellectual 
property. Failure to do so may void this Warranty with respect to such 
software and/or other intellectual property. 

8.3.5 Disclaimer of all Other Warranties 

The Warranty set forth in What Is Covered By This Warranty (page 116) are in 
lieu of all other warranties, express or implied, including but not limited to the 
implied warranties of merchantability and fitness for a particular purpose. 

8.3.6 Limitation of Remedies ** 

In no event will ProSoft or its Dealer be liable for any special, incidental or 
consequential damages based on breach of warranty, breach of contract, 
negligence, strict tort or any other legal theory. Damages that ProSoft or its 
Dealer will not be responsible for included, but are not limited to: Loss of profits; 
loss of savings or revenue; loss of use of the product or any associated 
equipment; loss of data; cost of capital; cost of any substitute equipment, 
facilities, or services; downtime; the claims of third parties including, customers of 
the Purchaser; and, injury to property. 

** Some areas do not allow time limitations on an implied warranty, or allow the exclusion or 
limitation of incidental or consequential damages. In such areas, the above limitations may not 
apply. This Warranty gives you specific legal rights, and you may also have other rights which vary 
from place to place. 
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8.3.7 Time Limit for Bringing Suit 

Any action for breach of warranty must be commenced within 39 months 
following shipment of the Product. 

8.3.8 No Other Warranties 

Unless modified in writing and signed by both parties, this Warranty is 
understood to be the complete and exclusive agreement between the parties, 
suspending all oral or written prior agreements and all other communications 
between the parties relating to the subject matter of this Warranty, including 
statements made by salesperson. No employee of ProSoft or any other party is 
authorized to make any warranty in addition to those made in this Warranty. The 
Customer is warned, therefore, to check this Warranty carefully to see that it 
correctly reflects those terms that are important to the Customer. 

8.3.9 Allocation of Risks 

This Warranty allocates the risk of product failure between ProSoft and the 
Customer. This allocation is recognized by both parties and is reflected in the 
price of the goods. The Customer acknowledges that it has read this Warranty, 
understands it, and is bound by its Terms. 

8.3.10 Controlling Law and Severability 

This Warranty shall be governed by and construed in accordance with the laws of 
the United States and the domestic laws of the State of California, without 
reference to its conflicts of law provisions. If for any reason a court of competent 
jurisdiction finds any provisions of this Warranty, or a portion thereof, to be 
unenforceable, that provision shall be enforced to the maximum extent 
permissible and the remainder of this Warranty shall remain in full force and 
effect. Any cause of action with respect to the Product or Services must be 
instituted in a court of competent jurisdiction in the State of California. 



ProLinx ♦ ProLinx Gateways Support, Service & Warranty 
Configuration and Troubleshooting  

 

Page 120 of 123  ProSoft Technology, Inc. 
April 14, 2011 

 

 



Index ProLinx ♦ ProLinx Gateways 
 Configuration and Troubleshooting 

 

ProSoft Technology, Inc. Page 121 of 123 
April 14, 2011 
 

Index 

[ 

[Data Map] • 86 
[MODULE] • 96 

4 

4101 Series LEDs • 79 
4101 Series Modules • 74 

A 

About ProSoft Configuration Builder • 19 
Adding a Location • 16, 20 
Adding a Module • 16, 20 
Adding a Project • 16 
Adding External (Web) Files • 30 
All Product Returns: • 114 
All ProLinx® Products • 3 
Allocation of Risks • 119 
Analyzing Data for the application port(s) • 65 
Antenna LED Indicators • 78 
Antenna Port (6000 Series Modules) • 57 
Application Data Area • 90 
Application Ports • 39 

B 

Backing Up Existing Files (Version 2.4 Modules) • 99 
Base Module LEDs • 75 

C 

CFG File Structure • 96 
Choose Module Type dialog box • 26 
Collision Avoidance (DNP modules only) • 42 
Comment Entries • 17 
Comment Records and Editing Hints • 98 
Common Tasks • 30 
Configuration File • 91 
Configuration View • 19, 24 
Configuration/Debug Port • 43 
Configure the Module • 16 
Connecting Power to the Unit • 12 
Connecting to the FTA • 50 
Connections for HART Analog Point-to-Point Devices • 

53 
Constructing a Bus Cable for PROFIBUS DP • 45 
Controlling Law and Severability • 119 
Copying Group Information • 30, 34 
Copying Module Information • 30, 34 

D 

Data Analyzer • 64 
Data Analyzer Tips • 67 
Data Map Edit Dialog box • 30 

Database View Menu • 69 
DB9 to Mini-DIN Adaptor (Cable 09) • 43 
Delay Preset • 88 
Deleting a Location • 31 
Deleting a Module • 31 
Deleting a Project • 31 
Determining the Version of Your ProLinx Module • 94 
Diagnostics and Troubleshooting • 7, 59 
Diagnostics dialog box • 27 
Disclaimer of all Other Warranties • 118 
Disclaimer Regarding High Risk Activities • 117 
Displaying the Current Page of Registers Again • 69 
Displaying Timing Marks in the Data Analyzer • 65 
Download Procedure for Version 2.2 Modules • 106 
Downloading a File from PC to the Module • 18, 32 
Downloading Files to a Version 2.4 Module • 103 
Downloading the Configuration File from Your PC to 

the Module • 109 

E 

Edit dialog box • 28 
Editing and Downloading CFG Files using NotePad 

and HyperTerminal • 94 
Editing Configuration Files • 97 
Enable Configurable Items • 31 
Error and Status Data • 81 
Ethernet Cable Configuration • 44 
Ethernet Configuration Entries • 33 
Ethernet LED Indicators • 75 
Ethernet Port • 44 
Exiting the Program • 64 
Exporting Configuration Files • 32, 36 

F 

Fixed Error and Status Data Register Locations • 82 
From Address • 87 
Functional Overview • 7, 85 

G 

General Specifications • 89 
General Specifications - Radio Modules • 89 
Getting Email Support • 36 
Guide to the ProLinx Reference Guide • 7 

H 

Hardware Specifications • 92 
HART • 52 
HART Analog • 53 
HART Channels • 52 
HART LED Indicators • 78 
Honeywell DE • 50 
Honeywell DE Master LED Indicators • 78 
How to Contact Us 

Technical Support • 114 

I 

Important Installation Instructions • 3 
Information View • 19, 24 
Install ProSoft Configuration Builder Software • 14 



ProLinx ♦ ProLinx Gateways Index 
Configuration and Troubleshooting  

 

Page 122 of 123  ProSoft Technology, Inc. 
April 14, 2011 

 

Intellectual Property Indemnity • 117 
Internal Database • 85, 90 

K 

Keystrokes • 62 

L 

LED Indicators • 7, 75 
Limitation of Remedies ** • 118 
LIMITED WARRANTY • 115, 116 

M 

Main Menu • 62 
Making the Required Connections • 106 
Master Command Error List Menu • 71 
Master Command List Menu • 72 
Mini-DIN 8 Serial Port • 75 
Modbus Plus • 51 
Modbus Plus Connections • 51 
Modbus Plus LED Indicators • 77 
Module Entries • 17, 33 
Module Status Data Map • 83 
Mounting the Module on the DIN Rail • 12 
Moving Back Through 5 Pages of Registers • 70 

N 

Navigation • 61 
Network Menu • 73 
Network Power Supply Requirements • 54 
No Other Warranties • 119 

O 

Opening the Data Analyzer Menu • 62 
Opening the Database Menu • 63, 81 
Optional Web Server for Ethernet Solutions • 91 
Overview and Purpose of the Configuration File • 96 

P 

Package Contents • 10 
Pasting Group Information • 34 
Pasting Module Information • 34 
Pinouts • 3, 39, 43, 44, 45, 49, 51, 54, 57 
Please Read This Notice • 3 
Port 0,1,2,3 

RS-232 - Modem Connection • 41 
RS-232 - Null Modem (with Hardware 

Handshaking) • 40 
RS-232 - Null Modem (without Hardware 

Handshaking) • 40 
RS-422 Interface Connections • 41 
RS-485 Interface Connections • 42 

Printing a Configuration File • 17 
Procedures for Return of Units Out of Warranty: • 115 
Procedures for Return of Units Under Warranty: • 115 
Product Specifications • 7, 89 
PROFIBUS Master LED Indicators • 76 
PROFIBUS Master Port • 44 
PROFIBUS Slave LED Indicators • 76 
PROFIBUS Slave Port • 49 

ProLinx 5108 / 5208 HART Field Connections • 53 
ProLinx Modules with Ethernet Ports • 4 
ProLinx Plus with Radio • 4 
ProSoft Configuration Builder • 19, 93 
Protocol Driver Access to the Database • 86 
Purchasing Warranty Extension: • 115 

R 

Redisplaying the Current Page • 71, 72 
Reference • 7, 89 
Register Count • 88 
Remote I/O Adapter Cable Connection • 57 
Removing Timing Marks in the Data Analyzer • 65 
Renaming a Location • 35 
Renaming a Module • 34 
Renaming a Project • 34 
Required Hardware • 59 
Requirements • 59 
Return Material Authorization (RMA) Policies and 

Conditions • 114 
Returning to the Main Menu • 66, 70, 71, 72, 74 
RIO • 57 
RJ45 • 44 
Rockwell Automation Remote I/O LED Indicators • 77 
RS-232 Serial Connection • 13 

S 

Select Protocol dialog box • 29 
Selecting a Protocol • 35 
Selecting a Tag • 35 
Sending the Log to a File • 37 
Serial Port Cable Connections 

Config/Debug and Port 0 • 39 
Multiple Port Units • 39 

Setting an External (Web) File Location • 35 
Setting Port 0 Configuration Jumpers • 11 
Skipping 500 Registers of Data • 70 
Special Ports • 44 
Start Here • 7, 9 
Starting the Data Analyzer • 66 
Status Data Area • 90 
Stopping the Data Analyzer • 66 
Support • 36 
Support, Service & Warranty • 7, 113 
Swap Code • 88 
System Requirements • 9 

T 

The Configuration/Debug Menu • 59 
Time Limit for Bringing Suit • 119 
To Address • 87 
To Order a Series C mode with the -WEB option: • 4 
To upgrade a previously purchased Series C model: • 

4 
Transferring a File from the Module • 35 
Transferring WATTCP.CFG to the module • 73 
Transferring WATTCP.CFG to the PC • 73 
Tree View • 19, 20, 25 



Index ProLinx ♦ ProLinx Gateways 
 Configuration and Troubleshooting 

 

ProSoft Technology, Inc. Page 123 of 123 
April 14, 2011 
 

U 

Upload/Download dialog box • 29 
Uploading and Downloading Configuration Files • 106 
Uploading the Configuration from the Module to Your 

PC • 100 
Uploading the Configuration from the Module to Your 

PC. • 107 
Uploading the WATTCP.CFG File (Modules with an 

Ethernet Port) • 102, 109 
User Interface • 26 
Using the Diagnostic Window in ProSoft Configuration 

Builder • 60 
Using the help system • 15 

V 

View Configuration dialog box • 29 
Viewing Block Transfer Statistics • 63 
Viewing Client Configuration • 64 
Viewing Data in ASCII (Text) Format • 65, 70 
Viewing Data in Decimal Format • 70 
Viewing Data in Floating Point Format • 70 
Viewing Data in Hexadecimal Format • 65, 70 
Viewing Diagnostic Information • 37 
Viewing Module Configuration • 63, 64 
Viewing Port Communication Status • 63 
Viewing Port Configuration • 64 
Viewing Register Pages • 69 
Viewing the Next 100 Registers of Data • 70 
Viewing the Next 20 Commands • 71 
Viewing the Next 50 Commands • 72 
Viewing the Next Page of Commands • 71, 72 
Viewing the Previous 100 Registers of Data • 70 
Viewing the Previous 20 Commands • 71 
Viewing the Previous 50 Commands • 72 
Viewing the Previous Page of Commands • 71, 72 
Viewing the WATTCP.CFG file on the module • 74 
Viewing Version Information • 63 
Views • 24 

W 

Warm Booting the Module • 64 
What Is Covered By This Warranty • 116, 118 
What Is Not Covered By This Warranty • 116 
Wireless • 57 
Wiring Diagrams • 54 

Y 

Your Feedback Please • 2 
 


